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Ievads

Pateicamies, ka izvēlējāties Medtronic Diabetes par savu partneri,  kas palīdzēs Jums un Jūsu

pacientiem labāk vadīt savu diabēta ārstēšanu. Mēs ticam, ka jūsu darbam būs noderīga

programmatūras CareLink® Pro jaunāko sasniegumu tehnoloģija un vienkārša  ar izvēlni

darbināma lietotāja saskarne.

Ar programmatūru CareLink Pro ir iespējams iegūt un saglabāt datus, kā arī ģenerēt atskaites

par pacienta ārstēšanu un diagnostiku. To var arī izmantot, lai piekļūtu datiem, kas attiecas uz

sūkni un mērītāju, kā arī no sensora iegūtiem glikozes līmeņa datiem, kurus jūsu pacienti ir

augšupielādējuši terapijas tīmekļa vadības sistēmā CareLink® Personal,  kas darbojas ar

programmatūru CareLink Pro.

Funkcijas

CareLink Pro ir diabēta terapijas vadības programmatūra personāliem datoriem (personal

computer — PC). Tai ir  šādas pazīmes:

• iespējams izveidot pacienta ierakstus, saglabājot no pacienta ierīces iegūtos datus, kā arī

terapijas datus no viņa CareLink Personal konta;

• insulīna sūkņu, monitoru un glikozes līmeņa asinīs mērītāju datus var nosūtīt uz sistēmu,

uzglabāt un pēc tam izmantot ziņojumu ģenerēšanai;

• programmatūrai ir arī iespēja saskaņoti darboties ar sistēmu CareLink Personal, ļaujot piekļūt

ierīces datiem, kurus pacienti ir tajā saglabājuši. Tas noder, lai izveidotu aktuālus ziņojumus

starp iestādes apmeklējumiem, tādēļ vairs nav nepieciešams nolasīt ierīces datus

apmeklējuma laikā;

• no pacienta ierakstos saglabātajiem ierīces datiem var izveidot dažādu ārstēšanas procesu

ziņojumus. Ziņojumi palīdz atrast atbildes uz ārstēšanas problemātiskiem jautājumiem,

piemēram, par to, kā pacients ievēro noteikumus, par modeļiem un izņēmumiem;

• sistēma brīdina, kad ir pieejami programmatūras jauninājumi lejuplādēšanai un instalēšanai.

Tādēļ Jums ir pieejamas jaunākās sistēmas iespējas;
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• lai palīdzētu tiem lietotājiem, kas programmatūru CareLink Pro tikai iepazīst, ir pieejama

funkcija Guide Me (Vadi mani). Tajā ir padomi par izpildāmajiem uzdevumiem;

• visā programmatūrā ir integrēta palīdzības sistēma, kas sniedz informāciju par interesējošām

jomām.

Drošība

• Programmatūru CareLink Pro var aizsargāt ar paroli.

• Pacienta datu pārsūtīšana no CareLink Personal konta ir šifrēta tipveida drošligzdu slāņa

(Secure Sockets Layer — SSL) tehnoloģija.

Saistītie dokumenti

Visos šajos Medtronic MiniMed dokumentos ir ierīcei specifiska informācija, kas nav sīki

izklāstīta šajā lietotāja rokasgrāmatā.

PIEZĪME: lai iegūtu informāciju par citu uzņēmumu mērītājiem, skatiet tiem pievienotās

ražotāja instrukcijas.

• Paradigm insulīna sūkņa lietotāja rokasgrāmata

• Guardian REAL-Time monitora lietotāja rokasgrāmata

• Sensora iespēju lietotāja rokasgrāmata

• ComLink lietotāja rokasgrāmata

• CareLink USB lietotāja rokasgrāmata

Palīdzība

Ja jums ir nepieciešama papildu palīdzība šīs sistēmas lietošanā, lūdzu, sazinieties ar vietējo

pārstāvi.  Starptautiskā kontaktinformācija atrodama šādā tīmekļa vietnē:

http://www.medtronicdiabetes.com/help/contact/locations.html

Atbalstītās ierīces

Programmatūra CareLink Pro saņem datus no turpmāk minētajām ierīcēm.

PIEZĪME: dažas šī  programmatūras atbalstītas ierīces var nebūt pieejamas visās valstīs,

kurās šī programmatūra ir apstiprināta lietošanai.
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Insulīna sūkņi/glikozes monitori

Sūkņi Medtronic MiniMed: 508

Medtronic MiniMed Paradigm® sērijas sūkņi: 511, 512, 712, 515, 715, 522,  722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Monitori Guardian REAL-Time:
CSS-7100

CSS-7100K

Ražotājs Glikozes līmeņa asinīs mērītāji

Medtronic diabēta partneru ierīces:
• Bayer CONTOUR® LINK

• Monitors BD Paradigm Link® glikozes līmeņa
asinīs noteikšanai

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

Bayer:

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

BD: • Logic®

Bayer Ascensia® DEX® kolekcija, tostarp šādi saderīgi
mērītāji:

• Ascensia® DEX®

• Ascensia® DEX® 2

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™ kolekcija, tostarp šādi saderīgi
mērītāji:

• Ascensia ® ELITE™

• Glucometer ELITE® XL
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Ražotājs Glikozes līmeņa asinīs mērītāji

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra™

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Sakaru ierīces

Com-Station
Lietošanai ar sūkni Medtronic MiniMed 508.
(Sīkāku informāciju par nepieciešamo aparatūru
skatīt Com-Station lietotāja rokasgrāmatā.)

ComLink

Lietošanai ar sūkni MiniMed Paradigm un
monitoru Guardian REAL-Time. (Sīkāku
informāciju par nepieciešamo aparatūru skatīt
ComLink lietotāja rokasgrāmatā.)

monitors Paradigm Link® glikozes līmeņa asinīs
noteikšanai

Lietošanai ar sūkni MiniMed Paradigm vai
monitoru Guardian REAL-Time. (Sīkāku
informāciju par nepieciešamo aparatūru skatiet
monitora Paradigm Link® glikozes līmeņa asinīs
noteikšanai lietotāja rokasgrāmatā.)

CareLink® USB Lietošanai ar MiniMed Paradigm sērijas insulīna
sūkni un monitoru Guardian REAL-Time.

Datu pārraides kabeļi

Lietošanai ar trešo personu glikozes līmeņa
mērītājiem. Katrs mērītāja ražotājs piegādā datu
pārraides kabeli.

Piezīme: ja mērītāja ražotājs seriālā kabeļa vietā
nodrošina USB kabeli,  jums ir jāveic ražotāja
nodrošinātā programmatūras draivera
instalēšana.

Turklāt arī noskaidrojiet pie mērītāja ražotāja, vai
tiek nodrošināta USB kabeļa draivera saderība ar
jūsu operētājsistēmu. Daži USB draiveri var
neatbilst 64 bitu operētājsistēmām.

Līdzvērtīgas ierīces

Lai pievienotu ierīci sistēmai, sarakstā jāizvēlas tās izgatavotājs un modelis.  Ja ierīces

izgatavotāja un modeļa nav sarakstā, meklējiet nākamajā tabulā ekvivalentu vēlamajam.

CareLink Pro Lietošanas instrukcija   Ievads 4



Ja jūsu pacients lieto kādu no šīm ierīcēm Atlasiet šo ierīci

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™

Precision Xceed™ Optium Xceed™

Pasūtīšana

Lai pasūtītu Medtronic diabēta izstrādājumus, sazinieties ar vietējo pārstāvi.  Starptautiskā

kontaktinformācija atrodama šādā vietrādī URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

PIEZĪME: mērītājus var pasūtīt attiecīgajos uzņēmumos.

Kā lietot šo rokasgrāmatu

PIEZĪME: šajā lietotāja rokasgrāmatā ir parādīti programmatūras ekrānu paraugi.

Faktiski lietotās programmatūras ekrāni var nedaudz atšķirties.

Terminu un funkciju definīcijas lasiet sadaļā “Vārdnīca”. Šajā rokasgrāmatā lietotie nosacījumi

ir definēti nākamajā tabulā.

Termins/stils Nozīme

Klikšķis Lai  atlasītu objektu, kas redzams uz ekrāna,
noklikšķiniet uz tā ar peles kreiso pogu.

Dubultklikšķis Lai  objektu uz ekrāna atvērtu, divreiz noklikšķiniet
uz tā ar peles kreiso pogu.

Labās pogas klikšķis Lai  atvērtu citu logu vai izvēlni,  noklikšķiniet uz
objekta ekrānā ar peles labo pogu.

Treknraksta  teksts
Izmanto pogu, ekrānu,  lauku vai izvēļņu iespēju
nosaukumiem. Piemēram: Patient > New Patient
(Pacients > Jauns pacients)

PIEZĪME: Nodrošina papildu informāciju par procedūru vai
darbību.
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Termins/stils Nozīme

UZMANĪBU!
Brīdina par iespējamām briesmām, kas, ja netiek
novērstas, var izraisīt nelielus vai mērenus
programmatūras vai aparatūras bojājumus.

BRĪDINĀJUMS:

Brīdina par iespējamām briesmām, kas, ja netiek
novērstas, var izraisīt nāvi vai nopietnus
ievainojumus. Tajā var būt aprakstītas arī
iespējamās nopietnās nevēlamās blakusparādības
un drošības apdraudējumi.

Lietotāja drošība

lietošanas norādījumi

Sistēmu CareLink Pro paredzēts izmantot kā rīku, kas palīdz kontrolēt diabētu. Šīs sistēmas

uzdevums ir saņemt informāciju no insulīna sūkņiem, glikozes līmeņa mērītājiem un sistēmām

glikozes līmeņa nepārtrauktai kontrolei un šo iegūto informāciju pārvērst CareLink Pro

ziņojumos. Ziņojumi sniedz informāciju, pēc kuras var identificēt tendences un izsekot

ikdienas aktivitātēm, piemēram, ogļhidrātu patēriņam, ēdienreižu laikiem, insulīna padevei un

glikozēs rādījumiem.

Brīdinājumi

• Sistēma paredzēta lietošanai veselības aprūpes speciālistiem, kuri pārzin diabēta ārstēšanu.

• Sistēmas rezultāti nav paredzēti medicīniskas konsultācijas sniegšanai, un tos nedrīkst

izmantot šādam nolūkam.

• Šo izstrādājumu vajadzētu lietot vienīgi kopā ar šajā dokumentā nosauktām atbalstītajām

ierīcēm. (Skatiet Atbalstītās ierīces lapā 2.)

• Pacientiem jāiesaka kontrolēt savu glikozes līmeni asinīs vismaz 4–6 reizes dienā.

• Pacientiem jānorāda, ka tiem nevajadzētu mainīt ārstēšanas režīmu, nekonsultējoties ar

veselības aprūpes speciālistu.

• Pacientiem jāiesaka pieņemt lēmumu par ārstēšanu, pamatojoties uz veselības aprūpes

speciālista ieteikumiem un mērītāja BG rezultātiem, nevis uz glikozes sensora rezultātiem.

Kontrindikācijas

Šo programmatūru nevajadzētu lietot ar ierīcēm, kas nav minētas Atbalstītās ierīces lapā 2.  Šo

programmatūru nevar arī izmantot citu veselības problēmu ārstēšanai,  izņemot diabētu.

Pirms šīs progrqammas atvēršanas aizveriet visas pārējās programmas, kas pašreiz darbojas

jūsu datorā:

• programmatūra CGMS® System Solutions™ (7310);

• programmatūra Solutions® Pumps & Meters (7311);

• programmatūra Guardian® Solutions® (7315);

• ParadigmPAL™ (7330);

• programmatūra CareLink® Personal (7333);

• programmatūra Solutions® izmantošanai ar CGMS®iPro (7319).
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Darba sākšana

Turpmākā informācija jums noderēs, lai uzsāktu darbu ar programmatūru CareLink Pro,

atvērtu un aizvērtu pacientu ierakstus un noteiktu prioritātes, kas sistēmā attiecas uz visiem

pacientiem.

Pirms darba sākšanas

Ja lietojat programmatūru CareLink Pro pirmo reizi,  pārliecinieties, vai ir  iestatītas vispārējās

prioritātes (skatiet Vispārējas prioritātes lapā 12). Šīs prioritātes nosaka, kā noteiktas lietas

tiek atveidotas programmātiski  un ziņojumos un kā sistēma komunicēs ar internetu.

Prioritātes var iestatīt jebkurā laikā. Jūs varat nogaidīt,  līdz apgūstat programmatūru CareLink

Pro, un tad iestatīt  citas prioritātes.

Sistēmas galvenie uzdevumi

Turpmākajā tabulā izklāstīti galvenie uzdevumi, kas būtu jāveic, pirmo reizi  uzstādot un

lietojot programmatūru CareLink Pro. Tajā arī  norādīts,  kurā šīs lietotāja rokasgrāmatas daļā ir

apskatīts katrs uzdevums.

Darbība Vieta

Iepazīstieties ar CareLink Pro lietotāja saskarni. Sistēmas navigācija lapā 8

Definējiet slimnīcā lietojamās kopējās sistēmas opcijas. Sistēmas prioritāšu iestatīšana lapā 11

Izveidojiet katram pacientam profilu. Jaunu profilu pievienošana lapā 20

Izveidojiet saiti ar savu pacientu CareLink Personal
kontiem.

Saites izveidošana ar CareLink Personal kontu
lapā 21

Pievienojiet pacienta profilam pacienta sūkni un
mērītājus. Ierīces pievienošana lapā 28

Nolasiet pacienta sūkņa un mērītāju rādījumus. Ierīces datu nolasīšana lapā 34

Sastādiet un ģenerējiet katram pacientam ziņojumus. Ziņojumu izveidošana lapā 37
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Darbība Vieta

Regulāri izveidojiet CareLink Pro datubāzes dublējumu. Datubāzes dublēšana lapā 47

Aktualizējiet CareLink Pro programmu. Programmatūras atjauninājumu izmantošana
lapā 46

Sistēmas navigācija

Pirms uzsākat darbu ar programmatūru CareLink Pro, iepazīstieties ar lietotāja interfeisu.

Lietotāja saskarnē ir izvēlnes, rīkjosla, navigācijas josla, darbtelpas un Guide Me (Vadi mani)

logs.

Programmatūras CareLink Pro atvēršana

1 Veiciet dubultklikšķi uz programmatūras CareLink Pro ikonas  sava datora darbvirsmā vai

izvēlnes Windows Start programmu sarakstā atlasiet Medtronic CareLink Pro.

Gadījumā, ja jūsu slimnīca prasa ievadīt paroli, tiek parādīts pieteikšanās ekrāns.

a. Ievadiet savu paroli laukā Password  (Parole).

PIEZĪME: paroles prasīšana ir izvēles iespēja, kas tiek iestatīta instalēšanas
procesā.

b. Noklikšķiniet uz LOGIN (Pieteikties).

Tiek parādīts startēšanas ekrāns.

2 Lai sāktu jaunu pacienta ierakstu, noklikšķiniet uz New Patient (Jauns pacients). Lai atvērtu

pacienta ierakstu, kas jau eksistē sistēmas pacientu sarakstā, noklikšķiniet uz Open Patient

(Atvērt pacientu).

Darbvietas

Ja pacienta ieraksts ir  atvērts,  var noklikšķināt uz vienas no navigācijas joslas pogām, lai

parādītos atbilstošā darbtelpa. Izmantojiet šīs  darbvietas, lai  ievadītu vai atlasītu informāciju,

kas nepieciešama, lai veiktu ar šo pacientu saistītos CareLink Pro uzdevumus.

Profile (Profils): ļauj apstrādāt saglabāto
pacienta informāciju, piemēram, vārdu un
dzimšanas datumu. Šajā darbvietā iespējams
arī izveidot saiti  ar pacienta CareLink Personal
kontu.

Devices (Ierīces): ļauj saglabāt informāciju,
kas nepieciešama, lai  nolasītu pacienta ierīču
mērījumus.

Reports (Ziņojumi): ļauj atlasīt parametrus un
izvēlēties, kādus ziņojumus par pacientu
ģenerēt.
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Kamēr pacientam nav pievienots un saglabāts profils, šim pacientam pieejama ir tikai

darbvieta Profile (Profils). Kamēr pacienta profilam nav pievienotas ierīces, šim pacientam ir

pieejamas tikai darbvietas Profile (Profils) un Devices (Ierīces).

Rīkjosla

Programmatūras CareLink Pro rīkjosla nodrošina iespēju ātri piekļūt bieži lietotām funkcijām.

Rīkjoslai ir  šādas pogas.

Pogas Nosaukums Funkcionalitāte

Add Patient (Pievienot
pacientu)

Atver darbvietu Profile (Profils),
ļaujot pievienot sistēmā jaunu
pacienta ierakstu.

Open Patient (Atvērt pacientu)
Atver pacienta pārlūktabulu,
kurā var izvēlēties un apskatīt
esošu pacienta ierakstu.

Guide Me (Vadi mani)

Parāda un paslēpj Guide Me
logu. Klikšķiniet, lai iegūtu
sistēmas ieteikumus konteksta
izpratnei.

Pacienta cilnes

Kad ir atvērts pacienta ieraksts,  rīkjoslā tiek parādīta cilne ar pacienta vārdu. Kad cilne ir aktīva,

arī pacienta ieraksts un darbvieta ir aktīvi,  tādēļ iespējams veikt ar pacientam saistītos

CareLink Pro uzdevumus.

Lai pacienta ieraksta lauks kļūtu aktīvs un jūs ar to varētu strādāt, noklikšķiniet uz šī pacienta

cilnes. Lai ierakstu aizvērtu, noklikšķiniet uz cilnes pogas Close  (Aizvērt) .

Funkcija Guide Me (Vadi mani)

Funkcija Guide Me (Vadi mani) tiek nodrošināta ar programmatūru CareLink Pro. Tā atver logu

ar kontekstā saprotamiem padomiem un ieteikumiem par darbībām, kuras iespējams veikt

aktīvajā sistēmas daļā. Funkcijas Guide Me (Vadi mani) logos var būt iekļautas arī saites
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>>learn more  (uzziniet vairāk).  Ja uz tām noklikšķina, tās atver tiešsaistes palīdzības

atbilstošās sadaļas ar sīkāku informāciju. Guide Me iespēja ir aktīva pēc noklusējuma. Taču to

jebkurā laikā var atslēgt.

Funkcijas Guide Me (Vadi mani) ieslēgšana un izslēgšana

Lai funkciju Guide Me (Vadi mani) ieslēgtu vai izslēgtu, rīkojieties šādi:

• noklikšķiniet uz pogas Add  (Pievienot) vai 

• atlasiet Help  > Guide Me  (Palīdzība > Vadi mani).

Pacienta ierakstu atvēršana

Vienlaicīgi var atvērt līdz sešiem pacienta ierakstiem. Ja neviens pacienta profils vēl nav

izveidots, skatiet Jaunu profilu pievienošana lapā 20.

1 Atlasiet File > Open Patient  (Fails > Atvērt pacientu) vai noklikšķiniet uz pogas Open

Patient  (Atvērt pacientu).  Tiks parādīts pacientu saraksts, kas līdzīgs tālāk redzamajam.
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PIEZĪME: ja saņemat paziņojumu, ka atvērts pārāk daudz pacientu ierakstu,

noklikšķiniet uz OK, aizveriet ierakstu un turpiniet.

2 Atrodiet pacientu sarakstā, ierakstot pacienta vārda daļu vai visu vārdu laukā Find a Patient

(Atrast pacientu). Kad pacienta ieraksts tiek izcelts, noklikšķiniet uz OPEN (Atvērt), veiciet

dubultklikšķi uz ieraksta vai nospiediet ENTER (Ievadīt). Pārvietoties sarakstā var arī ar

tastatūras augšupējo un lejupējo bulttaustiņu.

Tiek parādīta pacienta darbvieta Devices  (Ierīces) (ja ierīces vēl nav pievienotas) vai Reports

(Ziņojumi).

3 Lai redzētu pacienta darbvietu Profile (Profils), noklikšķiniet navigācijas joslā uz pogas

Profile  (Profils) .

Pacienta ierakstu aizvēršana

1 Pārliecinieties, vai pacienta ieraksts, kuru vēlaties aizvērt, ir aktīvs (cilne izcelta).

2 Veiciet vienu no šīm darbībām:

a. atlasiet File > Close Patient (Fails > Aizvērt pacientu);

b. noklikšķiniet pacienta cilnē uz pogas Close  (Aizvērt) ;

c. nospiediet taustiņu kombināciju Ctrl+F4.

Sistēmas prioritāšu iestatīšana

Sistēma piemēro šīs prioritātes visiem pacientiem. Lai iegūtu informāciju par prioritātēm, kas

ietekmē tikai atsevišķus pacientus, skatiet Ziņojuma iestatījumu pārbaude lapā 40.

Prioritātes tiek parādītas šādās grupās:

• Vispārējas

- Glikozes vienības

- Ogļhidrātu vienības

- Komunikācijas

- Problēmu novēršana

• Pacienta profils

- Izvēlieties un izkārtojiet pacientu profilu datu laukus.

• Pacienta informācijas atrašana

- Modificējiet un mainiet lauku parādīšanas secību, kad izvēlaties Open Patient, lai skatītu

pacientu sarakstu.

• Ziņojuma ģenerēšana

- Izvēlieties datu laukus, kurus vēlaties redzēt, kad datu tabulā izvēlēsieties Daily Detail

ziņojuma ievadi.
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Vispārējas prioritātes

Izmantojiet cilni General (Vispārējs),  lai noteiktu, kā programmatūra attēlos noteikta veida

informāciju, un nosakiet savas ārējās komunikācijas prioritātes.

1 Ja tā vēl nav aktīva, noklikšķiniet uz cilnes General (Vispārējs).

2 Atlasiet Tools > Options  (Rīki > Iespējas). Tiks parādīts šāds logs.

3 Ar klikšķi izvēlieties tās vērtības opciju pogu, kas jums nepieciešama:

- Glucose Units (Glikozes vienības): mg/dl vai mmol/l

- Carbohydrate Units  (Ogļhidrātu vienības): grami vai apmaiņas

a. Atlasot Exchanges (Apmaiņas), lai norādītu Carbohydrate Units  (Ogļhidrātu vienības),

ierakstiet piemērotu skaitli laukā grams are equal to 1 Exchange (grami, kas līdzvērtīgi

1 apmaiņai).

4 Lai atlasītu vai notīrītu izvēles rūtiņu, noklikšķiniet sadaļā Chart Options (Diagrammas

iespējas) > Overview Report (Pārskata ziņojums). Ja izvēles rūtiņa ir atlasīta,

lietojumprogramma ar līnijām savienos GA mērījumus diagrammā Meter Glucose Overlay

(Glikozes līmeņa mērījumu pārklājums). (Šī diagramma tiks parādīta sensora un mērītāja

pārskata ziņojumā.)

5 Noklikšķiniet, lai atlasītu izvēles rūtiņu (iespējot) vai lai to notīrītu (atspējot) turpmākām

komunikācijas prioritātēm.

PIEZĪME: iestatot komunikācijas prioritātes, ievērojiet savas slimnīcas vai IT
departamenta ieteikumus.
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- Programmatūras atjauninājumu automātiska pārbaude: ja šī prioritāte ir atlasīta,

ikreiz, kad būs pieejams programmatūras atjauninājums, katrai sistēmai, kurā darbojas

programmatūra CareLink Pro, tiks nosūtīts paziņojums. Tad aktīvajam lietotājam būs

iespēja lejuplādēt un instalēt aktualizētās versijas. Lai tas nenotiktu un būtu iespējams

kontrolēt programmatūras atjauninājumus, ir jāizņem atzīme no šī izvēles lodziņa.

- Veikt sinhronizāciju ar Medtronic CareLink® Personal: ja vēlaties, lai, katru reizi

atverot pacienta profilu, sistēma automātiski sinhronizē viņa CareLink Personal konta

datus, atlasiet šo izvēles rūtiņu. Ja šī kontrollodziņa izvēle tiek atcelta, CareLink Personal

dati katram pacientam būs jāsinhronizē manuāli.

6 Noklikšķiniet sadaļā Troubleshooting  (Traucējummeklēšana), lai atlasītu vai notīrītu izvēles

rūtiņu. Ja kontrollodziņš ir atzīmēts, lietojumprogramma saglabās ierīces rādījumu ierakstus

traucējummeklēšanas vajadzībām.

7 Lai saglabātu vispārējās prioritātes, noklikšķiniet uz OK (Labi).

Pacienta profila prioritātes

Šis ir vispārējs iestatījums, kas nosaka jūsu profila saturu. Lai iekļautu informāciju, kas jūsu

slimnīcai ir svarīgāka, varat pielāgot laukus darbvietā Profiles (Profili).  Varat pievienot vai dzēst

laukus, izveidot savus individuālos laukus un noteiktu kārtību, kādā lauki tiks parādīti logā.

1 Atlasiet Tools > Options  (Rīki > Iespējas).

2 Noklikšķiniet uz cilnes Patient Profile  (Pacienta profils). Tiks parādīts šāds logs.

PIEZĪME: ar kontrollodziņiem izvēlieties tos laukus, kurus vēlaties šajā profilā. Laukus
vēlamajā secībā novietojiet ar augšupējām un lejupējām bultiņām.

Datu lauku izvēlēšanās

1 Ar kontrollodziņiem pievienojiet vēlamos laukus.
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PIEZĪME: nav iespējams dzēst vārdu un uzvārdu.

2 Lauka izņemšanu no profila veic ar kontrollodziņa izvēles atcelšanu.

3 Lai lauku apzīmētu kā nepieciešamo, slejā Required  (Nepieciešams) atlasiet izvēles rūtiņu.

Nepieciešamais lauks jāaizpilda pirms profila izveidošanas.

Individuālu lauku pievienošana

1 Atzīmējiet kontrollodziņu pa kreisi no tukša individuālā lauka.

2 Ievadiet lauka nosaukumu (piemēram, Ārkārtas saziņa). Ar šādu nosaukumu šis lauks

parādīsies pacienta profilā.

3 Lai lauku apzīmētu kā nepieciešamo, atlasiet izvēles rūtiņu slejā Required  (Nepieciešams).

PIEZĪME: lai izņemtu individuālo lauku no profila, atceliet kontrollodziņa izvēli,  kas

atrodas blakus izņemajamam laukam.

Datu lauku secības maiņa

Atlasiet lauku, kuru vēlaties pārvietot, un, lai  to izdarītu, noklikšķiniet uz augšupvērstās vai

lejupvērstās bultiņas .  (Augšpuses un apakšpuses bultiņas pārvieto lauku no saraksta

augšas uz leju vai otrādi.)

Pacienta profila prioritāšu noformēšana

Kad lauku secības sarakstā visi nepieciešamie lauki ir pareizā secībā, noklikšķiniet uz OK  (Labi).

Tagad pacienta profilā izvēlētie lauki ir  vēlamajā secībā.

Pacienta informācijas uzmeklēšanas prioritātes

Pacienta informācijas uzmeklēšanas tabulu izmanto, lai meklētu un atvērtu pacienta ierakstus.

Tabulā ir informācija par visiem datubāzē esošajiem pacientiem, un tā nodrošina pacienta

profila informācijas atpazīšanu. Jums ir iespēja noteikt, kādu informāciju attēlot šajā tabulā un

kādā kārtībā tiks parādītas slejas. Lai pielāgotu pacienta informācijas uzmeklēšanas tabulu,

veiciet šādas darbības:

1 Atlasiet Tools > Options  (Rīki > Iespējas).
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2 Noklikšķiniet uz cilnes Patient Lookup  (Pacienta informācijas uzmeklēšana). Tiks parādīts

šāds logs.

PIEZĪME: ar kontrollodziņiem izvēlieties tos datus, kurus vēlaties pacienta

informācijas atrašanas tabulā. Slejas vēlamajā secībā novietojiet ar augšupējām un
lejupējām bultiņām.

Parādāmo datu izvēlēšanās

Lai atlasītu datu veidu, ko vēlaties atvērt,  vai dzēst tos, kurus nevēlaties atvērt pacienta

informācijas uzmeklēšanas tabulā, izmantojiet izvēles rūtiņu.

Sleju secības maiņa

Lai pacienta informācijas atrašanas tabulā mainītu sleju secību, atlasiet pārvietojamo sleju un

noklikšķiniet uz augšupvērstās vai lejupvērstās bultiņas.  (Ar augšupvērsto vai lejupvērsto

bultiņu datu sleju var pārvietot no saraksta augšas uz leju vai otrādi.)

Sleju rādīšanas secības augšpusē esošā datu sleja tiks parādīta pacienta informācijas atrašanas

tabulas pirmajā slejā. Apakšā esošā datu sleja tiks parādīta tabulas pēdējā slejā.

Pacienta informācijas atrašanas prioritāšu noformēšana

Kad sleju parādīšanas secības sarakstā visi nepieciešamie dati ir  pareizā secībā, noklikšķiniet uz

OK  (Labi).

Tagad pacienta informācijas atrašanas tabulā ir izvēlētie dati un sleju secība.
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Ziņojuma ģenerēšanas prioritātes

Datu tabula tiek parādīta ziņojumu atlases un ģenerēšanas logā. Šo tabulu izmanto,

ģenerējot ziņojumus. Tajā ir apkopota informācija, ko ikdienā iegūst no jūsu pacienta ierīcēm

un no programmatūras CareLink Personal konta, ja tas ir pieejams. Šajā tabulā apkopotā

informācija palīdz noteikt, kurās dienās ir nepieciešams ģenerēt detalizētu dienas ziņojumu.

Tas palīdz arī izlemt, kuru no pārējiem ziņojumiem vajadzētu ģenerēt.

Lai noteiktu, kuri dati jūsu praksei ir  atbilstošāki,  slimnīca var pielāgot tabulā attēlojamos

datus, tostarp arī kārtību, kādā tie tiek parādīti.

PIEZĪME: lai redzētu, kā šīs prioritātes ziņojuma izveidošanas procesā tiek piemērotas
datu tabulai,  skatiet Ziņojuma veida un iekļaujamo datumu atlase lapā 42.

1 Atlasiet Tools > Options  (Rīki > Iespējas).

2 Noklikšķiniet uz cilnes Report Generation  (Ziņojumu ģenerēšana). Tiks parādīts šāds logs.

Parādāmo datu izvēlēšanās

Lai izvēlētos datu veidu, ko vēlaties parādīt datu tabulā vai dzēst no tabulas, izmantojiet

kontrollodziņus.

Turpmāko informāciju var iekļaut datu tabulā.

Slejas nosaukums Definīcija

№ of Meter Readings (Mērītāja rādījumu skaits) Pievienotās ierīces noteiktā datumā veikto mērījumu
skaits.

Meter Readings Average (Mērītāja mērījumu vidējā
vērtība)

Vidējā vērtība pievienotās ierīces veiktajiem
mērījumiem, nosakot glikozes līmeni asinīs.
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Slejas nosaukums Definīcija

Sensor Duration (Sensora darbības laiks)
Laika apjoms, kurā noteiktajā datumā tika ierakstīti
sensora iegūtie dati.  Vērtības var būt --  (bez
vērtības), 0:05–24:00.

Sensor Average (Sensora datu vidējā vērtība) Noteiktajā datumā sensora veikto mērījumu vidējā
vērtība.

Highest Reading (Augstākais mērījums)
Noteiktajā datumā iegūtais glikozes līmeņa asinīs
augstākais mērījums (iegūts no sensora vai
mērītāja).

Lowest Reading (Zemākais mērījums) Noteiktajā datumā iegūtais glikozes līmeņa asinīs
zemākais mērījums (iegūts no sensora vai  mērītāja).

Avg AUC Below Target (Vidējais AUC zem mērķa)
Vidējais apgabals zem līknes (Area Under the
Curve — AUC) ir zemāks par pacientam noteikto
mērķa diapazonu.

Avg AUC Above Target (Vidējais AUC virs mērķa)
Vidējais apgabals zem līknes (Area Under the
Curve — AUC) ir virs pacientam noteiktā mērķa
diapazona.

Total Carbs (Kopējais ogļhidrātu daudzums)

Visu ogļhidrātu kopējais daudzums (atkarībā no
izmantotās mērījumu vienības, noapaļots līdz pilnam
gramam vai 0,1 apmaiņas vērtībai),  par kuru ziņots
noteiktajā dienā ar Bolus Wizard gadījumiem vai
ogļhidrātu atzīmēm uz sūkņa vai monitora
Guardian.

Suspend Duration (Apturēšanas ilgums)
Laiks, cik ilgi noteiktajā datumā tika apturēta sūkņa
darbība. Vērtības var būt --  (bez vērtības), 0:01–
24:00.

№ of Rewinds (Uzvilkšanas reižu skaits) Norāda skaitu, cik reizes noteiktajā datumā ierīce ir
uzvilkta.

№ of Primes (or Fills) (Uzpildīšanas reižu skaits) Skaits, cik reizes noteiktajā datumā ir veiktas atzīmes
par insulīna uzpildīšanu.

Prime (or Fill) Volume (U) (Iepildītais daudzums (U)) Noteiktajā datumā iepildīšanai izmantotais kopējais
insulīna daudzums.

Total Insulin (U) (Kopējais insulīna daudzums (U)) Noteiktajā datumā ievadītais un sūkņa nomērītais
kopējais insulīna daudzums.

Total Basal (U) (Kopējais bazālā insulīna daudzums (U))
Noteiktajā datumā ievadītā bazālā insulīna daudzums
(kopējais ievadītā insulīna daudzums, kas ir mazāks
par visu ievadīto bolus devu summu).

Total Bolus (U) (Kopējā bolus deva (U))
Noteiktajā datumā ievadītais un sūkņa atzīmētais
kopējais insulīna daudzums, kas sadalīts bolus
devās.

Basal  % (Procentuālā (%) bazālā deva) Norāda bazālās insulīna devas attiecību pret kopējo
insulīna daudzumu (pilnās % vērtībās).

Bolus % (Procentuālā (%) bolus deva) Norāda insulīna bolus devas attiecību pret kopējo
insulīna daudzumu (pilnās % vērtībās).

№ of Boluses (Bolus devu skaits) Noteiktajā datumā atzīmēto bolus devu skaits.

Bolus Wizard Events (Bolus Wizard gadījumi) Norāda skaitu, cik reizes noteiktajā datumā ierīce ir
atzīmējusi Bolus Wizard gadījumus.

Bolus Wizard Overrides (Bolus Wizard pārsniegtās
devas)

Gadījums skaits, kuros Bolus Wizard ievadītā insulīna
deva ir atšķīrusies no ieteiktās devas.

№ of Meal Boluses (Ēšanas bolus devu skaits)
Noteiktajā datumā atzīmēto gadījumu skaits, kuros
Bolus Wizard deva kopā ar uzņemtajiem ogļhidrātiem
ir bijusi lielāka par nulli.
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Slejas nosaukums Definīcija

№ of Correction Boluses (Bolus devu korekciju skaits)
Noteiktajā dienā atzīmēto gadījumu skaits, kuros
Bolus Wizard devu korekcijas ir bijušas lielākas par
nulli.

№ of Manual Boluses (Manuālo bolus devu skaits) Noteiktajā datumā atzīmētais skaits ievadītajām
bolus devām, kurām nav izmantots Bolus Wizard.

Sleju secības maiņa

Lai datu tabulā mainītu sleju secību, atlasiet pārvietojamo sleju un noklikšķiniet uz

augšupvērstās vai lejupvērstās bultiņas.  (Augšējās un apakšējās bultiņas pārvieto datu

sleju no saraksta augšas uz leju vai otrādi.)

PIEZĪME: sleju secības saraksta augšpusē esošie ieraksti tiks parādīti datu tabulas pirmajā

slejā. Apakšā esošie ieraksti tiks parādīti datu tabulas pēdējā slejā.

Ziņojuma ģenerēšanas prioritāšu noformēšana

Kad sleju secības sarakstā visi  nepieciešamie dati ir  pareizā secībā, noklikšķiniet uz OK  (Labi).

Tagad datu tabulā ir izvēlētie dati un sleju secība.
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3

Darbvieta Profile (Profils)

Profils ir līdzīgs medicīniskās kartes titullapai. Tajā ir tādi dati par pacientu kā vārds un

dzimšanas datums. Profils jāizveido, pirms sākt vākt ierīces datus un izmantot tos ārstēšanas

ziņojumos.

Darbvietā Profile (Profils) iespējams arī iestatīt saiti uz pacienta CareLink Personal kontu.

Kolīdz saite ir izveidota, jebkurā laikā iespējams nolasīt CareLink Personal kontā saglabātos

pacienta datus, kam nav nepieciešama pacienta klātbūtne.

Pirms darba sākšanas

Var būt nepieciešams pielāgot pacientu profilus tā, ka tie satur tikai tos datus, ko jūs vēlaties

savākt. Lai uzzinātu vairāk, skatiet Pacienta profila prioritātes lapā 13.

Iestatot saiti uz pacienta CareLink Personal kontu, ir nepieciešams arī lietotājvārds un parole.

Šie dati iegūstami pacienta klātbūtnē.
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Jaunu profilu pievienošana

Katru reizi,  kad sistēmā CareLink Pro tiek pievienots pacients, jāsāk ar pacienta profila

aizpildīšanu.

1 Atlasiet File > New Patient  (Fails > Jauns pacients) vai noklikšķiniet uz pogas Add Patient

(Pievienot pacientu). 

Tiek atvērta darbvieta Profile  (Profils).

PIEZĪME: lai  pacienta profilā pievienotu vai mainītu laukus, noklikšķiniet uz customize

fields (pielāgot laukus).  Skatiet Pacienta profila prioritātes lapā 13.

2 Aizpildiet laukus sadaļā Patient Profile (Pacienta profils).

3 Noklikšķiniet uz SAVE  (Saglabāt).

Jaunais pacienta profils ir pievienots programmatūras CareLink Pro datubāzei. Tiek parādīts

paziņojums, kas apstiprina, ka profils ir saglabāts.

Nepieciešamo lauku aizpildīšana

1 Ja, saglabājot pacienta profilu, nepieciešamie lauki nav aizpildīti, blakus attiecīgajam laukam

tiek parādīts paziņojums. Profilu nav iespējams saglabāt, kamēr laukos nav ierakstu.

2 Aizpildiet šo lauku.

3 Noklikšķiniet uz SAVE  (Saglabāt).

4 Kad tiek parādīts apstiprinājuma paziņojums, noklikšķiniet uz OK (Labi).

Pacientu profilu rediģēšana

1 Pārliecinieties, ka pacienta darbvieta Profile (Profils) ir atvērta.

2 Noklikšķiniet uz EDIT  (Rediģēt).

3 Rediģējiet datus sadaļā Patient Profile (Pacienta profils) pēc vajadzības.

4 Noklikšķiniet uz SAVE  (Saglabāt).

Tiek parādīts paziņojums, kas apstiprina, ka profils ir saglabāts.

Pacienta datu dzēšana no sistēmas

1 Pārliecinieties, ka pacienta darbvieta Profile (Profils) ir atvērta.

2 Pārliecinieties, ka šis ir pacients, kuru vēlaties dzēst. Dzēšot pacienta profilu, no

programmatūras CareLink Pro datubāzes tiek izņemti arī visi pacienta dati un tos vairs nav

iespējams atgūt.

3 Noklikšķiniet uz >> delete patient record  (dzēst pacienta ierakstu) virs profila

sinhronizēšanas sadaļas.
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Tiek parādīts brīdinājuma paziņojums, ka dzēšot ierakstu, tiks izdzēsti visi pacienta dati.

4 Lai izdzēstu pacienta ierakstu, noklikšķiniet uz Yes  (Jā).

Saites izveidošana ar CareLink Personal kontu

Ja pacients atļauj, jums ir iespēja iestatīt  saiti ar viņa CareLink Personal kontu. Šis tīkla rīks ļauj

pacientiem augšuplādēt un uzglabāt ierīces sniegtos datus, kā arī veidot dažādus ārstēšanas

ziņojumus.

Tiklīdz saite ar pacienta CareLink Personal kontu ir izveidota, jūs varat nolasīt viņa kontā

saglabātos ierīces datus. Šī informācija ir  noderīga, lai veidotu programmatūras CareLink Pro

terapijas ziņojumus starp pacienta vizītēm. Tādēļ arī nav nepieciešams nolasīt pacienta ierīces

rādījumus vizītes laikā.

Ja pacientam vēl nav CareLink Personal konta, jūs varat viņam nosūtīt e-pastu, aicinot tādu

izveidot.

Saites izveidošana ar esošu kontu

PIEZĪME: šīs darbības ir izpildāmas pacienta klātbūtnē.

1 Pārliecinieties, ka ir savienojums ar internetu.

2 Atveriet pacienta darbvietu Profile (Profils).

3 Pārliecinieties, ka visi nepieciešamie lauki sadaļā Patient Profile  (Pacienta profils) ir aizpildīti.

4 Noklikšķiniet uz LINK TO EXISTING ACCOUNT (Izveidot saiti ar esošu kontu).

Tiek parādīts pieteikšanās CareLink Personal kontā ekrāns.

5 Lūdziet pacientam izdarīt turpmākās darbības.

a. Ierakstīt savu lietotāja vārdu un paroli.

b. Noklikšķināt uz Sign In  (Reģistrēties).

Ņemot vērā pacienta reģistrācijas valodas un reģiona iestatījumus, tiek parādīta lapa Grant

Access (Piekļuves piešķiršana).

6 Lūdziet pacientam izdarīt turpmākās darbības.

a. Izlasīt Terms of Use (Lietošanas nosacījumi).

b. Atlasīt izvēles rūtiņu blakus I agree to the Terms of Use above...  (Piekrītu iepriekš

minētajiem lietošanas nosacījumiem).

c. Noklikšķināt uz Grant Access  (Piekļuves piešķiršana).

d. Informēt jūs, kad tiek parādīta lapa Thank You (Paldies).

7 Ja nepieciešams, noklikšķinot uz pogas Print  (Drukāt), ir iespējams izdrukāt lietošanas

nosacījumus, lai iedotu tos pacientam. Tagad jums ir izveidota saite ar pacienta CareLink

Personal kontu.
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E-pasta uzaicinājuma nosūtīšana

Lai nosūtītu pacientam e-pasta uzaicinājumu, izveidot CareLink Personal kontu, veiciet tālāk

minētās darbības.

1 Atveriet pacienta darbvietu Profile (Profils).

2 Pārliecinieties, ka visi nepieciešamie lauki sadaļā Patient Profile  (Pacienta profils) ir aizpildīti.

3 Noklikšķiniet uz SEND E-MAIL INVITATION TO PATIENT (Nosūtīt e-pasta ielūgumu

pacientam).

4 Pārliecinieties, ka lauki Patient Name (Pacienta vārds), Email (E-pasts) un Language (Valoda)

ir pareizi aizpildīti.

5 Noklikšķiniet uz SEND  (Sūtīt).

Pacienta profila statusa zonā parādās e-pasta nosūtīšanas apstiprinājums.

Datu iegūšana no saistītā konta

Ja saite ar pacienta CareLink Personal kontu ir izveidota, jaunie dati no tā tiek nosūtīti

automātiski ikreiz,  kad jūs atverat pacienta profilu programmatūrā CareLink Pro.

PIEZĪME: lai tas notiktu, dodieties uz Tools > Options > General (Rīki > Iespējas >

Vispārīgi) un pārliecinieties, ka ir atlasīta izvēles rūtiņa blakus “Synchronize with CareLink
Personal (Veikt sinhronizāciju ar CareLink Personal kontu)”.

Lai iegūtu pacienta CareLink Personal konta datus, katru reizi atverot pacienta profilu, veiciet

turpmākās darbības.

1 Pārliecinieties, ka pacienta darbvieta Profile (Profils) ir atvērta un ir aktīvs interneta

savienojums.

2 Atlasiet Tools > Synchronize Patient Data (Rīki > Sinhronizēt pacienta datus).

Sinhronizācijas ikona  pacienta cilnē griežas. Kad ikona apstājas, process ir pabeigts.
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PIEZĪME: ja pacients vairs nevēlēsies kopīgot ar jums savus CareLink Personal konta

datus, tiks parādīts paziņojums, jūs informējot par to.

3 Visi papildu dati, kas iegūti no CareLink Personal konta, būs redzami pacienta ziņojumos.

Pacienta CareLink Personal konta atsaistīšana no CareLink Pro

Pacienta CareLink Personal kontu var atsaistīt no CareLink Pro. Šī opcija ir pieejama vienīgi tad,

ja pacients bijis piesaistīts. Tas neļauj programmatūrai CareLink Pro turpmāk iegūt datus no

pacienta CareLink Personal konta. Taču tas netraucē pacientam izmantot savu CareLink

Personal kontu.

1 Atveriet pacienta ierakstu un piekļūstiet darbvietai Profile  (Profils).

2 Noklikšķiniet uz UNLINK ACCOUNT (Noņemt saiti uz kontu).

3 Apstiprinājuma paziņojumā klikšķiniet uz Yes. Pacienta personiskais profils vairs nav saistīts ar

programmatūru CareLink Pro.

Statuss mainās uz Not linked  (Nesaistīts), un tiek parādītas pogas LINK TO EXISTING

ACCOUNT  (Veidot saiti ar esošo kontu) un SEND E-MAIL INVITATION TO PATIENT (Nosūtīt

e-pasta ielūgumu pacientam).
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4

Aparatūras iestatīšana

Lai nolasītu datus tieši no ierīces, jums jābūt pieejamai pacienta ierīcei un visiem kabeļiem vai

komunikācijas ierīcēm, kas nepieciešamas, lai pārsūtītu datus uz datoru.

Ja pacients ir  lejupielādējis savus ierīces datus CareLink Personal kontā, pastāv iespēja datus

iegūt, izveidojot saiti ar pacienta kontu. Lai izveidotu saiti ar pacienta CareLink Personal kontu,

skatiet Saites izveidošana ar CareLink Personal kontu lapā 21.

Ierīču pievienošana

Apskatiet kopējo zīmējumu, lai gūtu vispārīgu ieskatu, kā jāuzstāda ierīces, lai tās komunicētu

ar datoru. Zīmējumos attēlotas arī atsevišķas ierīču komunikāciju detaļas.

Lai iegūtu papildu informāciju, ievērojiet instrukcijas, ko ierīču nolasīšanas laikā parāda

programmatūra CareLink Pro.
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Pārskats par aparatūras iestatīšanu

Šajā piemērā ir redzams, ka sūkņa komunikācijai ar datoru tiek izmantots CareLink USB.

Seriālo un USB kabeļu savienojumu piemēri:
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Papildu ComLink savienojums izmantošanai ar Paradigm sērijas sūkni:

Papildu ierīce Com-Station izmantošanai ar sūkni Medtronic MiniMed 508

CareLink Pro Lietošanas instrukcija   Aparatūras iestatīšana 26



5

Darbvieta Devices (Ierīces)

Informācija, kas jums būs nepieciešama, lai nolasītu pacienta ierīci, piemēram, ražojums,

modelis un sērijas numurs, atrodas darbvietā Devices (Ierīces).  Tādēļ tā nav jāievada ikreiz, kad

nolasāt ierīces datus.

Darbvietā Devices (Ierīces) informācija par ierīcēm tiek glabāta vienā no diviem sarakstiem —

Active Devices (Aktīvās ierīces) vai Inactive Devices (Neaktīvās ierīces).  Kad ierīce tiek

pievienota, informācija par to automātiski tiek ievietota sarakstā Active Devices (Aktīvās

ierīces). Datus var nolasīt tikai no sarakstā Active Devices (Aktīvās ierīces) parādītajām ierīcēm.

Tās, visticamāk, būs ierīces, ko pacients lieto pašreiz.

Citas pacientam piederošās ierīces, kas pašlaik netiek lietotas, var tikt saglabātas sarakstā

Inactive Devices (Neaktīvās ierīces). Tas saglabā informāciju failā. Šīs ierīces var aktivizēt

jebkurā laikā.
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Pirms darba sākšanas

Lai varētu atvērt pacienta darbvietu Devices (Ierīces),  sistēmā ir jābūt saglabātam profilam.

Skatiet Jaunu profilu pievienošana lapā 20.

Lai ierīci varētu pievienot vai nolasīt  datus no tās tieši, tai jākomunicē ar datoru. Lai uzzinātu,

kā ierīces iestatīt, lai tās komunicētu ar datoru, skatiet Ierīču pievienošana lapā 24.

Ierīces pievienošana

Informāciju par vēl nepievienotu ierīci var iegūt no pacienta CareLink Personal konta. Šīs

ierīces tiks automātiski pievienotas brīdi, starp programmatūru CareLink Personal un CareLink

Pro tiks veikta datu sinhronizēšana.

PIEZĪME: vienam pacientam aktīvs var būt tikai viens sūknis. Jauna sūkņa pievienošana

esošo sūkni pārvietos uz neaktīvo sarakstu.

Sūkņa Medtronic vai monitora Guardian pievienošana

1 Pārliecinieties, ka ierīce, kuru jūs pievienojat, ir uzstādīta komunikācijai ar datoru. (Informāciju

par savienojuma izveidošanu skatiet Ierīču pievienošana lapā 24.)

2 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda pacienta

informācijas uzmeklēšanas tabulā.

3 Lai piekļūtu pacienta darbvietai Devices (Ierīces), noklikšķiniet uz Devices  (Ierīces) .

4 Noklikšķiniet uz ADD DEVICE  (Pievienot ierīci).

5 Atlasiet Medtronic Pump/Guardian  (Medtronic sūknis/Guardian). Tiek parādīts vednis Add

Medtronic Pump/Guardian  (Pievienot Medtronic sūkni/Guardian).

PIEZĪME: sūkņa modelis ir  norādīts uz sūkņa aizmugures vai parādās sūkņa statusa

ekrānā.
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6 Lai norādītu pievienojamo ierīci, izvēlieties opciju pogu.

Ja ir atlasīta iespēja MiniMed 508 pump  (Sūknis MiniMed 508), veiciet 9. darbību.

7 Noklikšķiniet uz NEXT (Tālāk). Tiek parādīta lapa Serial Number  (Sērijas numurs).

PIEZĪME: ja netiek ievadīts pareizais sērijas numurs, parādās kļūdas paziņojums.

Pārbaudiet šajā lapā esošos piemērus un pārliecinieties, ka esat ierakstījis pareizās

rakstzīmes, kas redzamas sūkņa aizmugurē. Ja nepieciešams, no jauna uzrakstiet
sešas rakstzīmes.

8 Izmantojiet šīs lapas piemērus, kas palīdz atrast pievienojamās ierīces sešzīmju sērijas

numuru. (Ja tās atrašanai nepieciešama papildu palīdzība, noklikšķiniet uz >>learn more

(uzzināt vairāk).) Ievadiet sešas rakstzīmes laukā Device Serial Number (Ierīces sērijas

numurs).

9 Noklikšķiniet uz NEXT (Tālāk). Tiks parādīta lapa Communication Options (Komunikācijas

iespējas), kas ir līdzīga turpmākajai lapai.

10 Noklikšķiniet uz nolaižamās izvēlnes Choose Port  (Izvēlēties portu) un atlasiet pieslēgvietu,

kuru izmantojot ComLink, Paradigm Link®, CareLink USB vai Com-Station savienot ar datoru.

Ja nezināt, kuru pieslēgvietu izvēlēties, atlasiet Auto Detect (or USB)  (Automātiskā

noteikšana (vai USB)).
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11 Noklikšķiniet uz NEXT (Tālāk). Tiks parādīta lapa Test Connection  (Testa savienojums), kas ir

līdzīga šādai lapai.

12 Ievērojiet ierīces instrukcijas un noklikšķiniet uz TEST  (Tests).

Tiks parādīts paziņojums, kas informēs, ja savienojums būs izveidots. Ja tā notiek, veiciet

nākamo darbību.

PIEZĪME: šajā testā netiek nolasīti sūkņa dati,  bet tiek pārbaudīta komunikācija starp

sūkni un datoru.

Ja tā nenotiek, pārbaudiet, vai aparatūra ierīces un datora starpā ir pareizi savienota.

Noklikšķiniet arī vedņa lapās uz BACK (Atpakaļ), lai pārbaudītu, vai ievadītie ierīces dati ir

pareizi.

13 Noklikšķiniet uz DONE  (Gatavs).

Ierīce ir pievienota pacienta sarakstam Active Devices (Aktīvās ierīces).

Mērītāja pievienošana

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda pacienta

informācijas uzmeklēšanas tabulā.

2 Pārliecinieties, ka mērītājs, kuru jūs pievienojat, komunicē ar datoru. (Informāciju par

savienojuma izveidošanu skatiet Ierīču pievienošana lapā 24.)

3 Lai piekļūtu pacienta darbvietai Devices (Ierīces), noklikšķiniet uz pogas Devices  (Ierīces).

4 Noklikšķiniet uz pogas ADD DEVICE  (Pievienot ierīces).

CareLink Pro Lietošanas instrukcija   Darbvieta Devices (Ierīces) 30



5 Atlasiet Blood Glucose Meter  (Glikozes līmeņa mērītājs). Tiek parādīts vednis Add Blood

Glucose Meter (Pievienot glikozes līmeņa mērītāju).

6 Lai izvēlētos pareizo mērītāja modeli, noklikšķiniet uz opciju pogas.

7 Noklikšķiniet uz NEXT (Tālāk). Tiek parādīta lapa Meter Model  (Mērītāja modelis) (šī lapa

dažādiem mērītāju ražotājiem var būt atšķirīga).

8 Noklikšķiniet uz mērītāja modeļa, kuru pievienojat.
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9 Noklikšķiniet uz NEXT (Tālāk). Tiek parādīta lapa Communication Options  (Komunikācijas

iespējas).

PIEZĪME: pievienošanai atlasīt var tikai tos mērītājus, kas ir  apstiprināti.

10 Noklikšķiniet uz nolaižamās izvēlnes Choose Port  (Izvēlēties portu) un atlasiet pieslēgvietu,

kuru izmantojot ComLink, Paradigm Link vai CareLink USB savienot ar datoru. Ja nezināt, kuru

pieslēgvietu izvēlēties, atlasiet Auto Detect (or USB)  (Automātiskā noteikšana (vai USB)).

11 Noklikšķiniet uz NEXT (Tālāk). Tiek parādīta lapa Test Connection  (Testa savienojums).

12 Ievērojiet mērītāja instrukcijas, tad noklikšķiniet uz TEST (Tests).

Tiks parādīts paziņojums, kas informēs, ja savienojums būs izveidots. Ja tā notiek, veiciet

nākamo darbību.
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Ja tā nenotiek, pārbaudiet, vai aparatūra ierīces un datora starpā ir pareizi savienota.

Noklikšķiniet arī vednī uz BACK (Atpakaļ), lai pārbaudītu, vai ievadītie dati ir pareizi.

13 Noklikšķiniet uz DONE  (Gatavs).

Mērītājs ir pievienots pacienta Active Devices (Aktīvās ierīces) sarakstam.

Ierīces aktivēšana un dezaktivizēšana

Pacienta ierīces var pārvietot uz Active Devices (Aktīvās ierīces) un Inactive Devices (Neaktīvās

ierīces) sarakstu pēc vajadzības. Lai no ierīces nolasītu datus, tai jābūt aktīvai.

Active Devices (Aktīvās ierīces) sarakstā var pievienot tik daudz mērītāju, cik vēlaties, bet sūkni

tikai vienu. Pirms jauna sūkņa pievienošanas pārliecinieties, ka pašreizējais sūknis ir neaktīvs.

Ierīces dezaktivēšana

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda pacienta

informācijas uzmeklēšanas tabulā.

2 Lai piekļūtu pacienta darbvietai Devices (Ierīces), noklikšķiniet uz pogas Devices  (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet Atbalstītās ierīces lapā 2.

3 Zem ierīces, kuru vēlaties padarīt neaktīvu, noklikšķiniet uz >> make this device inactive

(padarīt šo ierīci neaktīvu). Ierīce tiek pārvietota uz sarakstu Inactive Devices  (Neaktīvās

ierīces).

Ierīces atkārtota aktivēšana

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda pacienta

informācijas uzmeklēšanas tabulā.

2 Noklikšķiniet uz pogas Devices  (Ierīces). Tiek parādīta pacienta darbvieta Devices  (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet Atbalstītās ierīces lapā 2.

3 Zem tās ierīces, kuru vēlaties aktivizēt, noklikšķiniet uz >> activate this device (aktivizēt šo

ierīci).

Ierīce tiek pārvietota uz sarakstu Active Devices  (Aktīvās ierīces).

Ierīces dzēšana

Izpildot šīs darbības, ierīce un tās dati tiek izdzēsti no darbvietas Devices (Ierīces) un no

sistēmas CareLink Pro.

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda pacienta

informācijas uzmeklēšanas tabulā.

2 Lai piekļūtu pacienta darbvietai Devices  (Ierīces), noklikšķiniet uz pogas Devices  (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet Atbalstītās ierīces lapā 2.

3 Pārliecinieties, vai ierīce ir redzama sarakstā Inactive Devices  (Neaktīvās ierīces). Ja nav, zem

tās pašreizējā saraksta noklikšķiniet uz >> Inactivate this device  (Padarīt šo ierīci neaktīvu).
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4 Zem ierīces, kuru vēlaties dzēst, noklikšķiniet uz >> delete this device  (dzēst šo ierīci). Tiek

parādīts brīdinājuma paziņojums, ka ierīce un visi tās dati tiks izņemti no pacienta ieraksta.

5 Lai ierīci izdzēstu, noklikšķiniet uz YES (Jā).

Ierīce un tās dati tiek izņemti no darbvietas Devices  (Ierīces) un no sistēmas CareLink Pro. Šīs

ierīces datus vairs nevar izmantot ziņojumiem.

Ierīces datu nolasīšana

Viens veids, kā iegūt ierīces datus, ir pieslēgties esošajam pacienta CareLink Personal kontam.

(Skatiet Saites izveidošana ar CareLink Personal kontu lapā 21.)  Cits veids ir tieša datu nolasīšana

no pacienta ierīces, kā aprakstīts šajā nodaļā.

Datus no pacienta ierīces var nolasīt,  izmantojot programmatūru CareLink Pro, ja ierīce ir

sarakstā Active Devices (Aktīvās ierīces) un tā komunicē ar datoru. Tiklīdz dati  ir  iegūti, tos var

izmantot ziņojumu sastādīšanai, kas palīdz novērtēt pacienta ārstēšanas vadību. Lai iegūtu

pieejamo ziņojumu īsu aprakstu, skatiet Par ziņojumiem lapā 43.

Izmantojot programmatūru CareLink Pro, no insulīna sūkņa iespējams iegūt šādus datus:

• dažādus sūkņa iestatījumus, piemēram, trauksmes režīmu, pīkstiena skaļumu un laika

rādījumu;

• piegādāto pamata insulīna daudzumu;

• bolus notikumus un ievadīto daudzumu;

• Bolus Wizard ierakstus;

• iniciēšanas daudzumu;

• apturēšanas laikposmus;

• sensora glikozes rādījumus laikposmā, sūkņiem ar sensora īpašībām.

Sistēma var iegūt datus arī no Guardian REAL-Time sistēmas, tostarp:

• sensora glikozes (SG) rādījumus;

• sensora koeficienta vērtības;

• sensora kalibrēšanas koeficientus;

• ēdienreižu marķierus;

• insulīna injekcijas.

Turklāt ierīces rādījumu nolasīšanas laikā sistēmā var augšupielādēt dažādu informāciju, kas

saglabāta asins glikozes mērītājā.
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BRĪDINĀJUMS: lūdzu, atceliet vai pabeidziet visu pagaidu bazālo vai aktīvo bolus devu

ievadīšanu un dzēsiet visus aktīvos trauksmes signālus. Sūkņa darbība tiks apturēta, lai

nolasītu mērījumus. Tiklīdz mērījumu nolasīšana ir pabeigta, lūdzu, pārbaudiet, vai sūkņa
darbība ir atjaunota.

UZMANĪBU! Sūkņa datu nolasīšanas laikā nelietojiet sūkņa tālvadības pulti.  Ja sūkņa

baterija ir  iztukšojusies, sūknis nesūtīs datus uz PC. Ja statusa rādījums liecina, ka
baterijā ir  maz enerģijas, nomainiet bateriju.

1 Noklikšķiniet uz pacienta cilnes vai veiciet dubultklikšķi uz pacienta vārda pacienta

informācijas uzmeklēšanas tabulā.

2 Pārliecinieties, ka ierīce komunicē ar datoru. (Skatiet Ierīču pievienošana lapā 24.)

3 Lai piekļūtu pacienta darbvietai Devices  (Ierīces), noklikšķiniet uz pogas Devices  (Ierīces).

Sarakstā ierīcēm var būt līdzvērtīgs ierīces nosaukums. Skatiet Atbalstītās ierīces lapā 2.

4 Atrodiet ierīci, no kuras vēlaties iegūt datus, sarakstā Active Devices  (Aktīvās ierīces) un

pārliecinieties, ka dati laukā Choose port (Izvēlēties portu) ir pareizi.

Ievadot informāciju par sūkņiem, noklikšķiniet uz nolaižamās izvēlnes Amount of Data  (Datu

apjoms) un atlasiet, cik daudz sūkņa datu vēlaties, lai programmatūra CareLink Pro nolasa.

5 Noklikšķiniet uz saistītās pogas READ DEVICE  (Nolasīt ierīci).

6 Ievērojiet ierīces instrukcijas un noklikšķiniet uz OK  (Labi).

7 Programmatūra CareLink Pro parāda norises joslu, kas atjauninās, lai parādītu, cik daudz

ierīces rādījumu jau nolasīts.

Ja ierīces nolasīšanas laikā noklikšķināsiet uz CANCEL  (Atcelt), tiks parādīts brīdinājuma

paziņojums, ka darbības atcelšana var izraisīt jau nolasīto datu zudumu. Lai atsāktu

augšupielādi, jānoklikšķina uz pogas READ DEVICE  (Nolasīt ierīci).

- Lai atceltu, noklikšķiniet uz YES  (Jā).

- Lai turpinātu lasīt ierīces datus, noklikšķiniet uz NO  (Nē).

Kad sistēma pabeidz ierīces datu nolasīšanu, tā atsūtīs paziņojumu, kas apstiprina, ka ierīce ir

pilnībā nolasīta.

8 Noklikšķiniet uz OK (Labi).

- Ievērojiet instrukcijas par sūkņu apturēšanas režīma pārtraukšanu.

Ja programmatūra CareLink Pro no ierīces datus nespēj iegūt, papildu ieteikumus skatiet

nodaļā “Problēmu novēršana”.
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6

Darbvieta Reports (Ziņojumi)

Programmatūra CareLink Pro nodrošina dažādu ziņojumu veidus, palīdzot labāk kontrolēt jūsu

pacientu diabēta terapiju. Katrā ziņojumā atrodamā informācija balstās uz datiem, kas iegūti

no pacienta ierīcēm un viņa programmatūras CareLink Personal konta.

Ziņojumus var ģenerēt uz ekrāna, sūtīt tieši  uz drukāšanas ierīci  vai saglabāt kā TIFF vai PDF

failus, kurus var pievienot elektroniskajam medicīniskajam ierakstam (EMR). Ar vienu darbību

var ģenerēt vairākus ziņojumu veidus.

Šajos ziņojumos parādītie dati ir  iegūti  no pacienta ierīcēm, viņa CareLink Personal konta vai

no abiem.

PIEZĪME: vairāk informācijas par ziņojuma sastāvdaļām un paraugziņojumus var skatīt

ziņojumu atsauces rokasgrāmatā. Ziņojumu atsauces rokasgrāmatai var piekļūt,
izmantojot programmatūru CareLink Pro, dodoties uz Help>View Report Reference Guide

(PDF) (Palīdzība>Skatīt ziņojumu atsauces rokasgrāmatu (PDF)) un atlasot atbilstošo

valodu.
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Pirms darba sākšanas

Ja jums ir zināms laikposms, kuru vēlaties atspoguļot ziņojumos, jābūt arī  pacienta ierīču

datiem par šo laikposmu. Var būt nepieciešama arī pacienta ierīču savienošana ar datoru, lai

pirms ziņojumu veidošanas iegūtu aktuālos datus.

Pirms ziņojuma ģenerēšanas neaizmirstiet rūpīgi izskatīt informāciju par darbību Verify

Report Settings  (Pārbaudīt ziņojumu iestatīšanu). Šajā vietā var precīzi iestatīt ziņojumu, lai

tas atlasītu jums nepieciešamos pacienta datus.

Ziņojumu izveidošana

Turpmākā sadaļa palīdzēs labāk izprast, kādi ziņojumu veidi ir pieejami un kas ir jādara, lai tos

ģenerētu.

Ja ziņojumu izveides process jums ir pazīstams un jūs zināt, kādus ziņojumus vēlaties

sagatavot, varat sākt ģenerēt ziņojumus.

Darbvietas Reports (Ziņojumi) atvēršana

Noklikšķiniet uz pacienta cilnes vai pogas Open Patient  (Atvērt pacientu)  un veiciet

dubultklikšķi  uz pacienta vārda.

Tiek atvērta darbvieta Reports  (Ziņojumi).

PIEZĪME: lai pārliecinātos, ka jūsu rīcībā ir jaunākie ierīces dati no pacienta CareLink

Personal konta, noklikšķiniet uz SYNC DATA (Sinhronizēt datus).

Ziņojuma laikposma atlase

1 Lai mainītu laikposmu, kura atspoguļojumu vēlaties iekļaut ziņojumā(-os), noklikšķiniet uz

nolaižamās izvēlnes Duration (Ilgums) un atlasiet posma ilgumu. (Maksimālais ilgums ir 12

nedēļas.)

2 Ja nav izvēlēta iespēja custom date range (pielāgots dienu diapazons), sākuma un beigu

datums tiek iestatīts automātiski.

PIEZĪME: ja izvēlēsieties garāku laikposmu nekā atļauts, saņemsiet kļūdas
paziņojumu. Koriģējiet ilgumu vai datumus.

Ja vēlaties dienu diapazonu pielāgot, noklikšķiniet uz nolaižamajām izvēlnēm From  (No) vai

Through  (Līdz) un atlasiet izvēlēto mēnesi, datumu vai gadu.

Datu kalendārs

Darbvietas Reports (Ziņojumi) datu kalendāra zonā tiek rādīts logs ar ziņojuma informāciju par

trīs mēnešiem.
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Zilajās joslās ir  ierīces dati. Oranžajā joslā ir  redzams jūsu atlasītais ziņojuma laikposms. Ja

ierīces datu un ziņojuma laikposmi pārklājas, jums ir dati par kādu vai visiem parādītajiem

ziņojuma laikposmiem.

Sākumā datu kalendāra zonā tiek parādīti pēdējie trīs mēneši. Lai  redzētu citus mēnešu,

noklikšķiniet uz bultiņu pogām , kas pārvietos uz attiecīgā mēneša sākumu vai beigām.

Iekļaujamo sākotnējo datu atlase

1 Ja pacients lieto BG mērītāju, kas savienots ar sūkni, mērītāja BG datu ziņošanai ar klikšķi

izvēlieties vienu no šādām opcijām:

- sūknī: šīs atlases priekšrocība ir tāda, ka jums jānolasa tikai pacienta sūkņa dati, GA

rādījumiem datumu piešķir sūknis un rādījumi ir tieši sasaistīti ar jebkuru izmantoto Bolus

Wizard aprēķinu. Trūkums ir tāds, ka, ja rodas kādas problēmas komunikācijā starp sūkni

un piesaistīto mērītāju, BG rādījumi par problemātisko laikposmu netiks ziņoti. Arī

MiniMed Paradigm sūkņiem, kas vecāki par 522/722, Bolus Wizard aprēķinu BG rādījumi,

kas nav izsekoti, netiks ziņoti.

- piesaistītajā(-os) mērītājā(-os):  šīs izvēles priekšrocība ir tāda, ka visi piesaistītajā mērītājā

saglabātie rādījumi tiks ziņoti. Trūkums ir tāds, ka, lai korelētu mērītāja un sūkņa datus,

jāpārliecinās, ka sūkņa un mērītāja pulksteņi ir savstarpēji sinhronizēti. Var arī nolasīt

sūkņa datus un piesaistītā mērītāja datus atsevišķi.

2 Lai pievienotu ierīces datus ziņojumiem, atzīmējiet kontrollodziņu blakus attiecīgajai ierīcei.

Nevar pievienot ierīces, kas nebija izvēlētas 1. solī. Lai to mainītu, izvēlieties cita piesaistītā

mērītāja opciju.

3 Lai izslēgtu ierīces datus no ziņojumiem, atceliet kontrollodziņa atzīmi blakus attiecīgajai

ierīcei.

Nevar atcelt opciju atzīmes, kas bija izvēlētas 1. solī. Lai to mainītu, izvēlieties cita piesaistītā

mērītāja opciju.

Ierīces datu pārbaudīšana

1 Darbvietā Reports (Ziņojumi) pārbaudiet datu kalendāru, lai pārliecinātos, ka oranžā josla,

kurā attēlots ziņojuma laikposms, pārklājas ar zilajām joslām, kurās attēloti ierīces dati.

2 Ja joslas pārklājas visā ziņojuma laikposmā, dati ziņojumam(-iem) ir pietiekami. Varat

noklikšķināt uz NEXT (Tālāk) un doties uz Ziņojuma iestatījumu pārbaude lapā 40.

3 Ja joslas nepārklājas vai pārklājas daļēji, ir vairākas iespējas:
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- koriģēt ziņojuma laikposmu;

- iegūt ierīces papildu datus.

Papildu datu iegūšana no ierīces

1 Lai iegūtu no ierīces vairāk datu, noklikšķiniet uz attiecīgās ierīces pogas READ DEVICE

(Nolasīt ierīci).

Tiek parādīta Read Device josla.

BRĪDINĀJUMS: lūdzu, atceliet vai pabeidziet visu pagaidu bazālo vai aktīvo bolus devu

ievadīšanu un dzēsiet visus aktīvos trauksmes signālus. Sūkņa darbība tiks apturēta,

lai nolasītu mērījumus. Tiklīdz mērījumu nolasīšana ir pabeigta, lūdzu, pārbaudiet,
vai sūkņa darbība ir atjaunota.

UZMANĪBU! Sūkņa datu nolasīšanas laikā nelietojiet sūkņa tālvadības pulti.  Ja sūkņa
baterija ir  iztukšojusies, sūknis nesūtīs datus uz PC. Ja ierīces statusa ekrāns rāda, ka

baterijā ir  maz enerģijas, nomainiet bateriju.

2 Pārbaudiet, vai dati laukā Choose port  (Izvēlēties portu) atbilst šai ierīcei.

Lai mainītu šo iestatījumu, klikšķiniet uz šī lauka nolaižamās izvēlnes un izvēlieties citu

iestatījumu.

3 Pārliecinieties, ka ierīce ir savienota ar datoru.

4 Ja šī ierīce ir sūknis, var norādīt, cik daudz datu no tās jāiegūst. Noklikšķiniet uz nolaižamās

izvēlnes Amount of Data (Datu apjoms) un atlasiet daudzumu.

PIEZĪME: ja atlasīts ir  All available data  (Visi pieejamie dati),  sistēma sūknī nolasīs
visus datus. Tādā veidā tiek no jauna pārrakstīti  sistēmā esošie dublējuma dati.

5 Noklikšķiniet uz READ DEVICE  (Nolasīt ierīci). Uzmanīgi izlasiet parādīto paziņojumu, jo tajā ir

konkrētas instrukcijas sūkņa datu nolasīšanai.

6 Ievērojiet instrukcijas un noklikšķiniet uz OK (Labi).

Tiek parādīta ierīces nolasīšanas virzības josla.

Nolasīšanu var atcelt jebkurā laikā, noklikšķinot uz CANCEL  (Atcelt).

Tiek parādīts paziņojums, kas apstiprina, ka nolasīšana ir pabeigta.

7 Noklikšķiniet uz OK (Labi).
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Tagad datu kalendārā tiek parādīti ierīces dati.

8 Noklikšķiniet darbvietas Reports (Ziņojumi) augšpusē uz NEXT  (Tālāk).

Tiek parādīts ziņojuma iestatījumu pārbaudes darbības logs. Tajā pirms ziņojuma(-u)

sastādīšanas var pārliecināties, vai iestatījumi konkrētajam pacientam ir pareizi.

Ziņojuma iestatījumu pārbaude 

1 Pārliecinieties, ka iestatījumiem Glucose Target  (Glikozes mērķa līmenis) ir norādītas

vajadzīgās vērtības. Lai palielinātu vai samazinātu vērtības, ierakstiet šīs vērtības vai

noklikšķiniet uz augšupvērstās vai lejupvērstās bultiņas laukos Low  (Zems) un High  (Augsts).

PIEZĪME: pamošanās un gulētiešanas laika grafikā, kā arī ēdienreižu atzīmju grafikā

tiek parādītas mērītāja rādījumu atzīmes (|| |).  Tā kā daži ziņojumi tiek balstīti uz

datiem, kas iegūti noteiktos ēdienreižu, pamošanās un gulētiešanas laikos, ir  svarīgi,
lai pacienta Bolus Wizard devas un mērītāja rādījumu atzīmes tiek atbilstoši

grupētas.

2 Lai pievienotu jaunu ēdienreizes laikposmu, noklikšķiniet uz ADD MEAL  (Pievienot

ēdienreizi). Lai rediģētu esošu ēdienreizes laikposmu, noklikšķiniet jebkurā vietā uz laika ass

jebkuras ēdienreizes laikposmā.

Ēdienreižu laikposma redaktors, kas atrodas zem laika ass, kļūst aktīvs.

PIEZĪME: var būt līdz piecām ēdienreizēm. Pēc noklusējuma ir brokastis,  pusdienas un

vakariņas.

3 Lai atlasītu vēlamos iestatījumus, ievadiet tekstu vai klikšķiniet uz bultiņām.

Ja vēlaties šos iestatījumus izmantot tikai šai ēdienreizei,  notīriet izvēles rūtiņu, kas atrodas

blakus Use these parameters for all of this patient’s meals  (Izmantot šos parametrus visām

šī pacienta ēdienreizēm).

- Meal Name:  ierakstiet nosaukumu, kuru vēlaties piešķirt šim ēdienreizes laikposmam.

- Meal Time Period: laiks stundās starp ēdienreizēm.

- Pre-Meal BG Target (mg/dL or mmol/L):  pacienta glikozes līmeņa asinīs mērķa

diapazona zemākās un augstākās vērtības pirms ēšanas.

- Pre-Meal Analysis Period:  laikposms, kurā glikoze līmenis asinīs tiks analizēts pirms

ēdienreizes sākuma. Šajā laikposmā iegūtie glikozes līmeņa asinīs rādījumi tiks izmantoti

detalizētai ziņojuma analīzei.

- Post-Meal BG Target (mg/dL or mmol/L):  pacienta glikozes līmeņa asinīs mērķa

diapazona zemākās un augstākās vērtības pēc ēšanas.

- Post-Meal Analysis Period:  laikposms, kurā glikozes līmenis asinīs tiks analizēts pēc

ēdienreizes. Šajā laikposmā iegūtie glikozes līmeņa asinīs rādījumi tiks izmantoti

detalizētai ziņojuma analīzei.
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Esoša ēdienreizes laikposma ilgumu, nomoda un miega periodu var mainīt, klikšķinot uz

sākuma vai beigu tura, velkot to pa laika asi un atlaižot.

PIEZĪME: ēdienreižu laikposmi nevar pārklāties, taču sākuma un beigu punkti var

robežoties viens ar otru. Ēdienreižu laikposmiem jābūt vismaz 60 minūtes ilgiem.

4 Lai izmantotu šīs ēdienreizes iestatījumus citām pacienta ēdienreizēm, pārbaudiet, vai izvēles

rūtiņa blakus Use these parameters for all of this patient’s meals (Izmantot šos

parametrus visām šī pacienta ēdienreizēm) ir atlasīta.

5 Pēc tam, kad ir pabeigta ēdienreizes laikposma izveide vai rediģēšana, noklikšķiniet uz SAVE

(Saglabāt).

6 Lai izņemtu ēdienreizes laikposmu, noklikšķiniet uz DELETE MEAL (Dzēst ēdienreizi). Kad tiek

prasīts apstiprinājums, noklikšķiniet uz DELETE (Dzēst).

7 Nākamajā reizē, kad sastādīsiet ziņojumu šim pacientam, programmatūra CareLink Pro

atcerēsies tam veiktos iestatījumus. Lai tos šim pacientam saglabātu, noklikšķiniet uz SAVE

SETTINGS (Saglabāt iestatījumus).

8 Noklikšķiniet darbvietas Reports (Ziņojumi) augšpusē uz NEXT  (Tālāk).

Šī ir norises darbība ziņojumu atlasei un ziņojumu ģenerēšanai. Tajā tiek sniegts ziņojumu

veidu saraksts, kā arī datu tabula, kas palīdz izvēlēties ikdienas detalizētajā(-os) ziņojumā(-os)

iekļaujamās vai neiekļaujamās dienas ar datiem.
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PIEZĪME: lai koriģētu datu tabulas attēlojumu, noklikšķiniet uz >>customize columns

(pielāgot kolonnas). Skatiet Ziņojuma ģenerēšanas prioritātes lapā 16.

9 Lai izdrukātu uz ekrāna redzamos rādījumus, noklikšķiniet uz ikonas PRINT  (Drukāt) .

Ziņojuma veida un iekļaujamo datumu atlase

1 Atzīmējiet kontrollodziņu blakus ziņojuma(-iem), ko vēlaties iekļaut ziņojumu komplektā.

2 Ja ziņojuma laikposmā sūkņa vai Guardian monitora dati nolasīti vairākas reizes, var

parādīties vairāki ierīces momentuzņēmumi:

a. Pārliecinieties, vai izvēles rūtiņa blakus Device Settings Snapshot  (Ierīces iestatījumu

momentuzņēmums) ir atlasīta.

b. Klikšķiniet uz nolaistās bultiņas un izvēlieties momentuzņēmuma datumu un laiku.

- Sūkņi: atlasiet momentuzņēmumu no pacienta sūkņa.

- Guardian:  atlasiet momentuzņēmumu no pacienta monitora Guardian.

Ja kāds lauks ir blāvs, ziņojuma laikposmā momentuzņēmumi nav pieejami.

3 Lai pārskatītu ikdienas detalizētā ziņojuma informāciju, ritiniet cauri datu tabulai.

- Katras slejas datus var šķirot. Lai datus sakārtotu augšupejošā secībā, klikšķiniet uz slejas

nosaukuma. Lai datus sakārtotu lejupejošā secībā, vēlreiz noklikšķiniet uz slejas

nosaukuma.

PIEZĪME: ja konkrētajā datumā nav datu, šo datumu izvēlēties nevar.

4 Atlasiet izvēles rūtiņu tajās datu tabulas rindās, kuras dienas datus vēlaties redzēt dienas

detalizētajā ziņojumā.

- Lai ar vienu klikšķi iekļautu ikdienas detalizētajā ziņojumā visus datumus vai izslēgtu tos

no ziņojuma, atlasiet izvēles rūtiņu datu tabulas izvēles rūtiņu slejas augšpusē.

Ziņojumu ģenerēšana

1 Kad ir pārbaudīta ziņojuma atlase, noklikšķiniet darbvietas Reports (Ziņojumi) augšpusē uz

GENERATE REPORTS (Ģenerēt ziņojumus).

Tiek parādīts opciju saraksts.

2 Izvēlieties ziņojuma(-u) priekšskatījuma, drukāšanas vai saglabāšanas opciju.

Atlasot iespēju Preview (Priekšskats), tiek parādīts logs Preview (Priekšskats).

3 Lai šķirstītu daudzlappušu ziņojumus, klikšķiniet uz bultiņu pogām.

4 Lai saglabātu vai izdrukātu ziņojumu(-us), loga Preview (Priekšskats) augšpusē noklikšķiniet

uz vienas no pārējām pogām.

5 Lai šo logu aizvērtu, loga augšējā labajā stūrī noklikšķiniet uz pogas Close (Aizvērt) .

CareLink Pro Lietošanas instrukcija   Darbvieta Reports (Ziņojumi) 42



Par ziņojumiem

Šajā nodaļā sniegti  visu ziņojumu apraksti.  Vairāk informācijas par ziņojuma sastāvdaļām un

paraugziņojumus var skatīt ziņojumu rokasgrāmatā. Ziņojumu atsauces rokasgrāmatai var

piekļūt programmatūrā CareLink Pro:

1 Help > View Report Reference Guide (PDF)  (Palīdzība > Skatīt ziņojumu atsauces

rokasgrāmatu (PDF)).

2 Izvēlieties ziņojumu rokasgrāmatas valodu.

CareLink Pro ziņojumiem ir šādi kopēji elementi:

• Report header (Ziņojuma galvene) — ziņojuma galvene satur identifikācijas informāciju,

piemēram, ziņojuma nosaukumu, pacienta vārdu un datu avotu;

• Carbohydrates and blood glucose levels  (Ogļhidrātu un glikozes līmenis asinīs) — grafikos

un diagrammās ogļhidrātu vienības parādītas slīprakstā, bet glikozes līmeņi asinīs treknrakstā;

• Weekend data  (Nedēļas nogales dati) — nedēļas nogales dienas ir treknrakstā, tādēļ tās ir

viegli identificēt;

• Legends  (Simbolu skaidrojumi) — simbolu skaidrojumi ir redzami katra ziņojuma apakšpusē.

Lai gan simbolus var izmantot daudzos ziņojumus, skaidrojumi ir unikāli katram ziņojumam.

Ziņojums par režīma ievērošanu

Ziņojumā par režīma ievērošanu tiek atspoguļots, kā tiek lietoti insulīna sūkņi un sensori,  kā arī

pacienta uzvedība saistībā ar nozīmēto terapiju. Tas sniedz atbildi  uz jautājumu "Vai bija

pietiekami daudz datu, lai sniegtu precīzu pacienta rīcības ainu, lietojot insulīna sūkni un

sensoru, ja tāds bija lietojams?" Tas sniedz arī atbildi uz jautājumu "Vai pacients ievēro

noteiktos ārstēšanas noteikumus?" Tas arī norāda, vai jums vajadzētu pārrunāt ar pacientu, kā

viņš pārvalda savu diabētu.

Sensora un mērītāja pārskata ziņojums

Sensora un mērītāja pārskata ziņojumā ir pacienta mērītāja katru dienu noteikto glikozes

līmeņu asinīs un vidējo lielumu grafisks attēlojums, ietverot sadalījumu pa stundām 24 stundu

garumā, un šo datu korelācija ar ēdienreizēm un miega režīmu. Ir  iekļauti arī statistikas dati

par pacienta glikozes līmeņa asinīs rādījumiem un insulīna patēriņu.

Ja tiek lietots sensors, līdzīga sensora datu analīze tiek ģenerēta kā šī ziņojuma pirmā lapa. Ja

sensora dati nav pieejami, kā pirmā lapa tiks ģenerēta mērītāja datu analīze.

Ziņojuma noslēguma lapa(-s) rāda, kā pacients kontrolē glikozes, ogļhidrātu un insulīna

patēriņu pa dienām. Katrā lapā parādīts, kā kontrole mainās dienas laikā visā ziņojuma

laikposmā, ietverot vienā lapā līdz 14 dienu rādījumus.
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Ierakstu žurnāla ziņojums

Ierakstu žurnāla ziņojumā ir glikozes mērītāja, ogļhidrātu un insulīna dati par katru ziņojuma

laikposma dienu. Tajā ir dienasgrāmata ar katras stundas notikumiem, kā arī dienas vidējie un

kopējie rādītāji.  Katrā lapā ir līdz 14 dienu ieraksti.  Ja ziņojuma laikposms ir ilgāks par 14

dienām, tiks ģenerētas papildu lapas.

Ierīces iestatījumu momentuzņēmums

Ierīces iestatījumu momentuzņēmuma ziņojumā ir attēlots pacienta sūkņa vai Guardian REAL-

Time monitora iestatījumu momentuzņēmumi konkrētā datumā un laikā. Tas palīdz saprast

citus ziņojumus, kā arī dokumentē pacienta iestatījumus.

Sūkņa un monitora iestatījumi tiek ierakstīti  vienīgi tad, kad ierīce tiek nolasīta. Ja ierīce nav

nolasīta ziņojuma laikposmā, neviens iestatījums nebūs pieejams.

Detalizēts dienas ziņojums

Detalizētajā dienas ziņojumā tiek parādīti glikozes dati,  ogļhidrātu daudzums un pacienta

insulīna patēriņš izvēlētā dienā. Katrai datu tabulā izvēlētai  dienai tiek ģenerēts atsevišķs

ziņojums.

Detalizētais dienas ziņojums sniedz detalizētu pārskatu par katru atlasīto dienu. Tādēļ

iespējams koncentrēties uz konkrētu dienu, ja jums šķiet, ka pacienta ārstēšanā noticis kaut

kas ievērības cienīgs.

Datu eksportēšana

Iegūtos ierīces datus var eksportēt un saglabāt, izmantojot programmatūru CareLink Pro. Tā

ļauj izmantot visus pacienta ierīces datus statisktikas iegūšanai vai  specifisku ziņojumu un

diagrammu izveidošanai. .csv failu var importēt Microsoft Excel programmā vai atsevišķās

klīniskās statistikas programmās, kur to var papildus apstrādāt.

.csv faili  satur datus, kuros ierakstītas ierīces darbības. Piemēram, tajos ir mērītāja rādījumu

ieraksti,  sūkņa ieraksti, kas saņem mērītāja rādījumu vērtības, pamata ātruma izmaiņas.

PIEZĪME: tā ir  papildu iespēja, tādēļ jums jāpazīst ierīces jēldati.  Šim nolūkam

nepieciešama arī to programmu pārzināšana, kurā tiek importēts .csv fails.

Lai izmantotu programmatūras CareLink Pro eksportēšanas funkciju, veiciet turpmākās

darbības.

1 Noklikšķiniet uz pacienta cilnes vai pogas Open Patient (Atvērt pacientu)  un veiciet

dubultklikšķi uz pacienta vārda.

2 Pārliecinieties, ka tiek parādīta darbvieta Reports  (Ziņojumi).

3 Lai iestatītu datumu un ziņojuma laikposma ilgumu, izmantojiet laukus Duration  (Ilgums) vai

From/Through (No/Līdz).
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Maksimālais ilgums, ko var izvēlēties, ir 12 nedēļas.

4 Noklikšķiniet uz saites export selected data (eksportēt atlasītos datus).

Tiek parādīts dialoglodziņš Export Data to CSV File  (Eksportēt datus uz CSV failu).

5 Virzieties uz vietu, kur savā datorā vēlaties saglabāt .csv failu. Ja vēlaties mainīt faila

nosaukumu, ierakstiet to lodziņā File name  (Faila nosaukums).

6 Noklikšķiniet uz SAVE  (Saglabāt).

PIEZĪME: lai iegūtu papildu informāciju par datiem, kas tiek parādīti CSV failos,
skatiet CSV datu pielikumu.

Tagad .csv fails ir saglabāts jūsu datorā izvēlētajā vietā. To var importēt citās programmās, kas

atbalsta šo faila veidu.

CareLink Pro Lietošanas instrukcija   Darbvieta Reports (Ziņojumi) 45



7

Sistēmas administrēšana

Ir svarīgi regulāri  veidot CareLink Pro datubāzes dublējumu. Datubāzē glabājas visi sistēmas

dati,  kas ir uzkrāti jūsu pacientu ierakstos, ietverot profila informāciju, ierīču datus un

ziņojumu iestatījumus.

Ir arī svarīgi,  lai būtu pieejama jaunākā programmatūras CareLink Pro versija.  Atjauninātās

versijas ir  pieejamas periodiski,  un tajās var būt nozīmīgi uzlabojumi. Jūs varat pats meklēt

jauninājumus, bet varat izvēlēties, lai par tiem tiek jums paziņots.

Programmatūras atjauninājumu izmantošana

Programmatūrai CareLink Pro būs pieejami neregulāri atjauninājumi. Kad tiek parādīts

paziņojums par jauninājumu, jaunākās programmatūras versijas lejuplādei veiciet šādus

soļus.

PIEZĪME: pirms programmatūras atjauninājumu instalēšanas ir jādublē datubāze. Skatiet

Datubāzes dublēšana lapā 47.

1 Pārliecinieties, vai jūsu datoram ir savienojums ar internetu un tas ir aktīvs.

2 Kad ir pieejams programmatūras CareLink Pro atjauninājums, tiek parādīts CareLink Pro

Update paziņojums. Tas piedāvā jauninājumu lejuplādēšanas opciju.

3 Noklikšķiniet uz DOWNLOAD  (Lejupielādēt). (Ja noklikšķināsiet uz CANCEL  (Beigt),

atjauninājuma paziņojums aizvērsies. Jauninājumu varēs lejuplādēt vēlāk).

Tiek parādīts brīdinājuma paziņojums, kas iesaka veikt datubāzes dublējumu.

4 Lai izveidotu datubāzes dublējumu, noklikšķiniet uz YES (Jā) (informāciju par šo procedūru

skatiet Datubāzes dublēšana lapā 47). Ja datubāzes dublējums jau ir izveidots, noklikšķiniet

uz NO  (Nē).

Tiks parādīts paziņojums, kas apstiprinās, ka jaunā programmatūras CareLink Pro versija ir

lejupielādēta.
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5 Lai sāktu lietot jaunāko programmatūras CareLink Pro versiju, noklikšķiniet uz YES  (Jā), lai

aizvērtu un atkal atvērtu lietojumprogrammu. Ja nevēlaties veikt programmatūras CareLink

Pro restartēšanu, noklikšķiniet uz NO (Nē).

Automātiskās atjaunināšanas atslēgšana

Ja nevēlaties saņemt automātiskos paziņojumus par programmatūras CareLink Pro

atjauninājumiem, veiciet turpmākās darbības.

1 Atlasiet Tools  > Options  (Rīki > Iespējas).

2 Noklikšķiniet uz cilnes General (Vispārīgi).

3 Saziņas sadaļā izņemiet atzīmi no izvēles rūtiņas, kas atrodas blakus Automatically check for

software updates  (Automātiski pārbaudīt programmatūras atjauninājumus).

Manuāla jauninājumu pārbaude

Jebkurā laikā iespējama manuāla programmatūras CareLink Pro atjauninājumu pārbaude.

PIEZĪME: pirms programmatūras atjauninājumu instalēšanas ir jādublē datubāze. Skatiet

Datubāzes dublēšana lapā 47.

1 Pārliecinieties, vai jūsu datoram ir savienojums ar internetu un tas ir aktīvs.

2 Atlasiet Tools > Check for Software Updates (Rīki > Pārbaudīt programmatūras

atjauninājumus).

3 Ja pašreiz jauninājumu nav, saņemsiet paziņojumu. Ja ir pieejams jauninājums, tiks parādīts

CareLink Pro Update paziņojums.

4 Ievērojiet procedūru, kas aprakstīta Programmatūras atjauninājumu izmantošana lapā 46.

Datubāzes dublēšana un atjaunošana

Lietderīgi  ir  izveidot grafiku, saskaņā ar kuru tiks veidoti regulāri  datubāzes dublējumi. Tas

palīdzēs nodrošināt, ka tas tiek veikts regulāri,  un samazinās datu zuduma risku.

Ja datubāzes dublēšanas vai atjaunošanas laikā pie citiem datoriem būs aktīvi  programmas

lietotāji,  sistēmā tiks parādīts brīdinājuma ziņojums.

Datubāzes dublēšana

Lai dublētu pašreizējo datubāzi izvēlētajā vietā, veiciet šādus soļus.

1 Pārliecinieties, vai visi pacientu ieraksti ir aizvērti.

2 Atlasiet Tools > Backup Database (Rīki > Dublēt datubāzi).

PIEZĪME: datubāzes dublējumus var saglabāt tīkla diskā vai noņemamā krātuvē
(piemēram, DVD, CD vai USB diskdzinī).
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3 Virzieties uz vietu savā datorā, kur vēlaties saglabāt dublējuma failu. Ja vēlaties mainīt

dublējuma faila nosaukumu, ierakstiet to lodziņā File name  (Faila nosaukums).

4 Noklikšķiniet uz Save (Saglabāt). Datubāzes saglabāšanas darbības laikā tiek parādīta procesa

virzības josla.

Kad dublējums ir pabeigts, tiek parādīts paziņojums.

5 Lai aizvērtu paziņojumu, noklikšķiniet uz OK (Labi).

Datubāzes atjaunošana

Ja datubāzei vairs nevar piekļūt vai to lietot,  var būt nepieciešams to aizvietot. Jo nesenāk ir

veikts dublējums, jo mazāk datu zaudēsiet,  aizvietojot datubāzi.

UZMANĪBU! Veicot datubāzes atjaunošanu no dublējumkopijas, tiks zaudēti visi jaunākie

dati,  kas pašreizējā datubāzē tika izveidoti pēc atlasītās dublējumkopijas izveidošanas.

Lai aizvietotu esošo datubāzi ar dublējumkopiju, veiciet šādus soļus.

1 Pārliecinieties, vai visi pacientu ieraksti ir aizvērti.

2 Atlasiet Tools > Restore Database (Rīki > Atjaunot datubāzi).

3 Izvēlieties dublējuma failu, kuru vēlaties izmantot pašreizējās datubāzes aizvietošanai (parasti

visjaunāko).

4 Noklikšķiniet uz Open  (Atvērt). Tiks parādīts brīdinājuma ziņojums, kas atgādinās par

iespējamo datu zudumu, ja turpināsiet datubāzes atjaunošanu.

5 Lai turpinātu, noklikšķiniet uz OK (Labi). Datubāzes atjaunošanas darbības laikā tiek parādīta

procesa virzības josla.

Kad datubāze ir atjaunota, tiks parādīts paziņojums.

6 Lai aizvērtu paziņojumu, noklikšķiniet uz OK (Labi).

Ja sistēma nav pieejama

Ja mēģinat ieslēgt sistēmu, kamēr cits lietotājs veic dublēšanu vai atjaunošanu, jūs saņemsiet

paziņojumu par to, ka sistēma nav pieejama. Kamēr šis uzdevums nav pabeigts, jūs nevarēsiet

piekļūt sistēmai.

Veiciet vienu no šīm darbībām:

• nogaidiet, līdz process tiek pabeigts un sistēma ir pieejama;

• lai izietu un mēģinātu vēlāk vēlreiz, noklikšķiniet uz CANCEL  (Atcelt).
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8

Problēmu novēršana

Šī nodaļa palīdzēs atrisināt problēmas, kas rodas, lietojot programmatūru CareLink Pro. Tajā ir

atrodami arī norādījumi kā, ja nepieciešams, veikt programmatūras CareLink Pro atinstalēšanu.

Vispārējas lietojumprogrammas kļūdas

Mēģinot lejuplādēt programmatūras jauninājumus internetā, Jūs varat saņemt paziņojumu, ka

Jums nav privilēģiju to darīt. Lai lejupielādētu programmatūras CareLink Pro jauninājumus,

jābūt administratora privilēģijām.

1 Aizveriet programmatūras CareLink Pro lietojumprogrammu un restartējiet datoru.

2 Lūdziet, lai kāds ar administratora privilēģijām piesakās datorā.

3 Ievērojiet instrukcijas, kas atrodamas Programmatūras atjauninājumu izmantošana lapā 46.

Nav savienojuma ar datubāzi

Kļūdas paziņojums par to, ka nav savienojuma ar datubāzi,  nozīmē vienu no šādām iespējām:

• Datubāze ir pārvietota. Datubāzei jāatrodas turpat, kur tā atradās programmatūras CareLink

Pro instalēšanas brīdī. Ja tā ir pārvietota, tā jāatgādā atpakaļ turpat, kur tā bija instalēšanas

laikā.

• Nav savienojuma ar tīkla disku, uz kura atrodas datubāze. Ja datubāze atrodas uz tīkla diska,

tīklam reizēm var būt problēmas, kas neļauj piekļūt diskam. Sazinieties ar datoratbalsta

departamentu, kas palīdzēs no jauna savienoties ar tīkla disku, uz kura atrodas datubāze.

Aizmirsta klīnikas parole darbam ar CareLink Pro

Ja parole, ar kuru jūsu slimnīca piesakās programmatūrā CareLink Pro, ir  aizmirsta, jāveic jauna

programmatūra instalēšana un jaunas datubāzes izveidošana. Kad programmatūra būs

instalēta no jauna, vairs nevarēs piekļūt iepriekšējā datubāzē saglabātajai  pacienta

informācijai. Lai  nezaudētu turpmākos datus, veicot jauno instalēšanu, saglabājiet izveidoto

paroli birojā.
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Ierīces nolasījumu kļūdas

Kļūda Izskaidrojums

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is  available, or select another port.
(Izvēlēto seriālo pieslēgvietu nevar atvērt. Šajā
pieslēgvietā var noritēt cita darbība. Lūdzu, uzgaidiet,
kamēr pieslēgvieta atbrīvojas vai meklējiet citu
pieslēgvietu.)

Lūdzu, pārbaudiet, vai izvēlēto COM pieslēgvietu
neizmanto cita programma, vai izvēlieties citu
pieslēgvietu. Mēģiniet atsāknēt izmantoto datoru,
pēc tam mēģiniet vēlreiz veikt ierīces nolasīšanu.
Pieslēgvietai  pievienotā aparatūra (piemēram,
kabelis) var būt bojāta, vai pati pieslēgvieta var būt
bojāta. Pievienojiet aparatūru citai pieslēgvietai un
mēģiniet vēlreiz nolasīt ierīci,  lai noteiktu
problēmu.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port.
(Automātiskās noteikšanas funkcija neatrod ierīci
nevienā pieslēgvietā. Lūdzu, pārbaudiet kabeļa
savienojumu, ierīces akumulatoru un statusu, tad
mēģiniet vēlreiz vai norādiet seriālo pieslēgvietu.)

Pārbaudiet kabeļa un PC savienojumu, kā arī
pārbaudiet, vai baterijas statuss ir labs. Ja tā ir,
mēģiniet Auto Detect izvēles vietā norādīt PC
seriālo pieslēgvietu, kurai pievienot kabeli.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Atlasītajā seriālajā pieslēgvietā ierīce
nav atrodama. Lūdzu, pārbaudiet kabeļa savienojumu,
ierīces akumulatoru un statusu, un mēģiniet vēlreiz;
atlasiet citu pieslēgvietu vai noteikt ierīci ar
automātiskās noteikšanas funkciju.)

Pārbaudiet kabeļa un PC savienojumu, kā arī
pārbaudiet, vai baterijas statuss ir labs. Ja tā ir,
mēģiniet izvēlēties citu PC seriālās pieslēgvietas
numuru vai izvēlieties Auto Detect opciju.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and try
again. (Nevar sazināties ar ierīci.  Lūdzu, pārliecinieties,
ka esat pievienojis un izvēlējies pareizo ierīci,
pārbaudiet kabeļa savienojumu, ierīces bateriju un tās
statusu, un mēģiniet vēlreiz.)

Pārbaudiet visus ierīces nolasīšanas iestatījumus,
ieskaitot ierīces nosaukumu, seriālo numuru un
savienojuma veidu. Tāpat pārbaudiet, vai ierīce,
kabelis un PC ir pareizi savienoti.  Pārbaudiet, vai
ierīces baterijas un trauksmes signāla statuss ir
kārtībā. Mēģiniet nolasīt  vēlreiz.

Unexpected response...  retrying (n%). (Negaidīta
atbilde...  atkārtots mēģinājums (n%).)

No ierīces nolasīta negaidīta vērtība. Sistēma
mēģinās sazināties atkārtoti,  kamēr komunikācija
netiks atcelta vai izdosies.

The link device was found, but the device (<serial #>) is
not responding. Please verify the pump’s serial number,
place the pump closer to the communication device to
minimize interference, check pump battery and status.
(Saiti veidojošā ierīce ir noteikta, bet sūknis (sērijas Nr.)
nereaģē. Lūdzu, pārbaudiet sūkņa sērijas numuru,
novietojiet sūkni tuvāk komunikācijas ierīcei,  lai
mazinātu signāla traucējumus, pārbaudiet sūkņa
akumulatoru un tā statusu.)

Pārbaudiet, vai ievadīts pareizais sērijas numurs. Ja
nav, atkārtoti ievadiet pareizo seriālo numuru. Ja
sērijas numurs ir pareizs, pārvietojiet saiti veidojošo
ierīci  tuvāk komunikācijas ierīcei.  Pārvietojiet saiti
veidojošo ierīci un komunikācijas ierīci tālāk no
iespējamiem traucējumu avotiem (piemēram, citām
RF ierīcēm). Pārbaudiet ierīces akumulatora jaudu
un, ja tiek lejupielādēts insulīna sūknis, pārbaudiet
sūkņa piegādes statusu.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again. (Šis sūknis padod īslaicīgo pamata devu. Lūdzu,
atceliet īslaicīgo pamata devu vai pagaidiet, kamēr tā
tiek pabeigta, pēc tam mēģiniet vēlreiz.)

Sūknis, kuru gribat nolasīt,  pašlaik padod īslaicīgo
pamata devu. Lai nolasītu sūkni,  pagaidiet, kamēr
tiek pabeigta īslaicīgās pamata devas padošana, vai
atceliet īslaicīgo pamata devu un pēc tam nolasiet
sūkni.

This device has active errors or alarms. Please clear the
alarms and try again. (Šim sūknim ir aktīvas kļūdas vai
trauksmes signāli.  Lūdzu, iztīriet trauksmes signālus un
mēģiniet vēlreiz.)

Sūknim ir aktīvi  trauksmes signāli,  kas var traucēt tā
nolasīšanu. Lai trauksmes signālus iztīrītu, izlasiet
trauksmes signālu instrukcijas. Iztīriet trauksmes
signālus un mēģiniet sūkni nolasīt  vēlreiz.
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Kļūda Izskaidrojums

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again. (Šis sūknis
padod bolus devu. Lūdzu, atceliet bolus devu vai
pagaidiet, kamēr tā tiek pabeigta, pēc tam mēģiniet
vēlreiz.)

Sūknis, kuru gribat nolasīt,  pašlaik padod bolus
devu. Lai nolasītu sūkni, pagaidiet, kamēr tiek
pabeigta bolus padošana, vai atceliet bolus devu un
pēc tam nolasiet sūkni.

The device returned invalid entries; all data read will be
discarded. (Ierīce atsaka nederīgus ierakstus; visi datu
nolasījumi tiks atmesti.)

Sazinieties ar vietējo pārstāvi (skatiet Palīdzība
lapā 2).

Ziņojuma izveidošanas kļūdas

Daudz datu ierakstu ar vienādu datumu

Ja tām pašām ierīcēm tajā pašā datumā un laikā eksistē vairāki ieraksti,  sistēma uzskata, ka tas

ir konflikts, kuru tā nevar atrisināt.  Ziņojumos, kas izveidoti,  izmantojot šīs ierīces datus, daļa

datu, kas pārklājas, tiks izlaista.

Lai izlaistu pārklājuma datus, var mēģināt koriģēt ziņojuma laikposmu vai arī izņemt ierīci no

sistēmas, pēc tam to pievienot atpakaļ,  lai  iztīrītu iepriekšējos rādījumus.

Sistēma ignorē datus

Ja ierīces laiks ir  mainīts tā, ka tas rada datu pārklājumus vai iztrūkumus trīs stundas vai ilgāk,

sistēma šo datu daļu neietver, veidojot ziņojumus.

Dublējuma un atjaunošanas kļūdas

Datubāzi nevar bloķēt

Tas nozīmē, ka jūs izmantojat datubāzi daudzlietotāju vidē, kurā ir pieteikušies citi lietotāji.

Sistēma neļaus veikt datubāzes dublēšanu, kamēr citi  lietotāji,  iespējams, veic uzdevumus, kas

var ietekmēt datubāzi.  Kad citi lietotāji ir izgājuši  no programmatūras CareLink Pro, var

izveidot datubāzes dublējumu.

Datubāzes dublējums vai atjaunošana nav pabeigta

Citi lietotāji  nevar pieteikties un dublējumu vai atjaunošanu nevar pabeigt. Lūdzu, sazinieties

ar vietējo pārstāvi (skatiet Palīdzība lapā 2).

Datubāzes atjaunošana neizdodas

Datubāzes dublējuma fails,  no kura jūs mēģināt atjaunot bāzi,  ir  bojāts.  Mēģiniet atjaunošanu

no cita dublējuma faila.

Programmatūras atinstalēšana

Ja nepieciešams atinstalēt programmatūru CareLink Pro, veiciet turpmākās darbības.

1 Windows izvēlnē Start (Sākt) atveriet Control Panel (Vadības panelis).

CareLink Pro Lietošanas instrukcija   Problēmu novēršana 51



2 Atlasiet Add or Remove Programs  (Pievienot vai izņemt programmas). Tiks parādīts logs

Windows programmu pievienošana vai izņemšana.

3 Ritiniet uz leju līdz Medtronic CareLink Pro  un noklikšķiniet uz tā.

4 Noklikšķiniet uz Remove  (Izņemt). Tiek parādīts Instalēšanas ekrāna vednis.

5 Noklikšķiniet uz NEXT  (Tālāk). Tiek parādīts paziņojums, kurā tiek lūgts apstiprināt, ka vēlaties

izņemt lietojumprogrammu.

6 Noklikšķiniet uz Yes  (Jā). Notiek programmas atinstalēšana, un no jūsu datora tiek izņemta šī

programma ar visiem tās failiem. Kad tas ir izdarīts, vedņa ekrānā tiek parādīts paziņojums,

kas apstiprina atinstalēšanu.

7 Noklikšķiniet uz Finish  (Pabeigt).
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Ikonu tabula

Uz iepakojuma marķējuma un aparatūras esošās ikonas un simboli izskaidroti nākamajā

tabulā:

Apraksts Ikona

Viena vienība konteinerā/iepakojumā (1X)

CD iekļauts

Uzmanību: izlasiet lietošanas instrukcijās visus
brīdinājumus un norādījumus par piesardzības
pasākumiem.

Ražošanas datums (gads)

Kataloga numurs

Conformité Européene (Eiropas atbilstība). Šis simbols
norāda, ka ierīce pilnībā atbilst  Direktīvai 93/42/EEK par
medicīnas ierīcēm un Direktīvai 1999/5/EK par
radioiekārtām un telekomunikāciju termināla iekārtām.
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CSV dati

Veicot datu eksportēšanu no programmatūras CareLink Pro, dati tiek pārvietoti  .csv failā. Šo

failu iespējams importēt izklājlapu lietojumprogrammā, piemēram, Microsoft Excel.  Visu CSV

failā ietveramo datu uzskaitījumu skatiet definīcijās CSV faila slejā.

CSV failā ir  ietverta informācija ar pacienta vārdu un pacienta ID, ziņojuma laikposmu un

identificēta katra ziņojumā iekļautā ierīce.

Slejas datu definīcijas

Slejas nosaukums Definīcija

Index (Rādītājs) Secība, kādā dati tika ierakstīti ierīcē.

Date (Datums) Datums, kurā dati tika ierakstīti ierīcē.

Time (Laiks) Laiks, kurā dati tika ierakstīti ierīcē.

New Device Time (Jauns ierīces laiks) Jauns datums un laiks, ja tas ierīcē ticis mainīts.

BG Reading (mg/dL or mmol/L) (BG rādījums (mg/dl
vai mmol/l))

Asins glikozes rādījums, ko ierakstījis mērītājs,
Guardian vai sūknis. Ja dati ir no sūkņa vai monitora
Guardian, šajā slejā tiek atspoguļoti manuāli ievadīti
GA rādījumi vai GA rādījumi, kas saņemti no
piesaistītā mērītāja.

Linked BG Meter ID (Piesaistīta BG mērītāja ID) Mērītāja, kurš sūta konkrētu asins glikozes rādījumu
uz ierīci,  sērijas numurs.

Basal  Rate (U/h) (Pamata ātrums (U/h)) Aktīvais pamata insulīna padeves ātrums vienībās/
stundā.

Temp Basal Amount (Īslaicīgās pamata padeves
daudzums)

Ja sūknī tiek izmantota pagaidu bazālā deva, šī
vērtība ir pagaidu bazālās devas lielums.

Temp Basal Type (Īslaicīgās pamata padeves veids) Īslaicīgā pamata padeves veida korekcija (insulīna
ātrums vai procenti no pamata ātruma).

Temp Basal Duration (m) (Īslaicīgās pamata padeves
ilgums (m))

Īslaicīgās pamata insulīna padeves laiks minūtēs
(skatīt veidu iepriekš).

Bolus Type (Bolus devas veids) Bolus insulīna padeves veids [parastais, Square, Dual
(parastā daļa) vai Dual (kvadrāta daļa)].

Bolus Volume Selected (U) (Izvēlētais bolus devas
tilpums (U))

Izvēlētais insulīna vienību skaits, kas jāievada insulīna
bolus devas veidā.
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Slejas nosaukums Definīcija

Bolus Volume Delivered (U) (Padotais bolus devas
tilpums (U))

Faktiski padotais insulīna vienību skaits, kas faktiski
ievadīts insulīna bolus devas veidā.

Programmed Bolus Duration (h) (Ieprogrammētais
bolus ievadīšanas ilgums (h))

Square bolus vai Dual wave bolus kvadrāta daļas
ievades ilgums.

Prime Type (Iniciēšanas veids)

Manuāls vai fiksēts. Manuālā uzpilde tiek lietota
uzreiz pēc uzvilkšanas, lai piepildītu insulīna infūzijas
komplekta caurulītes ar insulīnu pirms to
ievadīšanas. Fiksēto izmanto pēc tam, kad infūzijas
komplekts ievietots, lai pēc ievadīšanas adatas
izņemšanas piepildītu mīksto kanulu ar insulīnu.

Prime Volume Delivered (U) (Padotais iniciācijas devas
tilpums (U))

Insulīna vienību skaits, kas faktiski tika izmantots
uzpildīšanai.

Alarm (Trauksme) Trauksmes signāla nosaukums.

Suspend (Apturēt) Identificē apturēta sūkņa statusu.

Rewind (Pārtīt) Ierīces pārtīšanas datums un laiks.

BWZ Estimate (U) (BWZ aprēķins (U)) Bolus insulīna aprēķins, ko veic ar Paradigm sūkņa
Bolus Wizard opciju.

BWZ Target High BG (mg/dL or mmol/L) (BWZ mērķa
augsts BG (mg/dl vai mmol/l))

Glikozes līmeņa asinīs mērķa diapazona augšējās
robežas iestatījums, ko lieto Bolus Wizard opcijā.

BWZ Target Low BG (mg/dL or mmol/L) (BWZ mērķa
zems BG (mg/dl vai mmol/l))

Glikozes līmeņa asinīs mērķa diapazona apakšējās
robežas iestatījums, ko lieto ar Bolus Wizard
funkciju.

BWZ Carb Ratio (BWZ ogļhidrātu daļa)

Insulīna un ogļhidrātu attiecības iestatījums. Ja kā
vienības izmanto gramus, attiecība ir gramu skaits, ko
noārda viena insulīna vienība. Ja kā vienības izmanto
apmaiņas, attiecība ir insulīna vienību skaits, ko
izlieto vienai apmaiņai.

BWZ Insulin Sensitivity (BWZ insulīna jutība)
Insulīna jutības iestatījums. Insulīna jutība ir asins
glikozes līmeņa lielums, ko samazina viena insulīna
vienība. To izmanto Bolus Wizard opcija.

BWZ Carb Input (BWZ ogļhidrātu ievade) Ogļhidrātu daudzums, kas ievadīts Bolus Wizard
opcijā un ko lieto, lai aprēķinātu bolus.

BWZ BG Input (mg/dL or mmol/L) (BWZ BG ievade
(mg/dl vai  mmol/l))

Glikozes līmeņa asinīs rādījums,  kas ievadīts Bolus
Wizard opcijā un ko lieto, lai aprēķinātu bolus.

BWZ Correction Estimate (U) (BWZ korekcijas aprēķins
(U))

Bolus insulīna vienības, lai veiktu asins glikozes
līmeņa korekcijas, kas aprēķinātas ar Bolus Wizard
funkciju.

BWZ Food Estimate (U) (BWZ pārtikas aprēķins (U))
Aprēķinātās bolus insulīna vienības, lai nosegtu
paredzēto ogļhidrātu patēriņa daudzumu, kas
aprēķinātas ar Bolus Wizard funkciju.

BWZ Active Insulin (U) (BWZ aktīvais insulīns (U))

Aprēķinātais aktīvā insulīna daudzums, kas palicis
organismā no iepriekšējām bolus insulīna devu
padevēm, nosakot aprēķināto bolus daudzumu ar
Bolus Wizard opciju.

Sensor Calibration BG (mg/dL or mmol/L) (Sensora
kalibrācijas BG (mg/dl vai mmol/l))

BG vērtība, ko izmanto sensora kalibrēšanai mg/dl
vai  mmol/l.
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Slejas nosaukums Definīcija

Sensor Glucose (mg/dL or mmol/L) (Sensora glikoze
(mg/dl vai  mmol/l)) Sensora glikozes vērtība.

ISIG value (ISIG vērtība) Ievades signāli (ISIG), ko nolasa no sensora un mēra
nanoampēros (nA).

Vairāk par CSV failiem, ko eksportē CareLink Pro.

Nosaukums CSV faila augšpusē ietver:

• pacienta vārdu

• izvēlēto ierīču sarakstu un to seriālos numurus

• izvēlēto datu diapazonu

Katram sleju blokam ir nosaukums, kas ietver:

• ierīces nosaukumu, kurai piemēro datu bloku

• šīs ierīces seriālo numuru

Ja dati netiek parādīti, kā paredzēts

Ir vairāki  iemesli,  kādēļ CSV dati tiek parādīti citādi nekā paredzēts.

• Ierīces datuma vai laika maiņa var mainīt rādīšanas secību vai iznest ierakstus ārpus izvēlētā

parādāmā datumu diapazona.

• Ja starp ierīces nolasījumiem ir liela atstarpe, šīs ierīces dati var būt parādīti vairākos blokos.
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Vārdnīca

A1c -  glikozēts hemoglobīns

A1c tests - hemoglobīna A1c tests, ko izmanto, lai izskaidrotu glikozes līmeni asinīs kādā laika periodā
(dinamikā).

Apgabals zem līknes (Area Under the Curve — AUC) - norāda augsto un zemo noviržu lielumus,
kurus nosaka pēc iepriekš iestatītām vērtībām. Noviržu dati rāda augsto un zemo noviržu biežumu.
AUC rāda notikumu svarīgumu, parādot, cik tālu tie ir no normālā diapazona un cik ilgi tie turpinās.

Apturēt - sūkņa funkcija, ar kuru aptur insulīna padevi. Visas notiekošās un/vai iniciējošās padeves
tiek atceltas. Pamata padeve tiek apturēta līdz restartēšanai.

Audio bolus - sūkni var ieprogrammēt tā, lai, atlasot bolus insulīna devas lielumu (0,5 vai 1,0 vienība),
lietotājs sadzird pīkstienu. Tas noder situācijās, kad ir grūti redzēt sūkņa pogas.

BG - glikozes līmeņa asinīs saīsinājums

Bolus devas korekcijas faktors - par cik 1,0 insulīna vienība pazemina jūsu glikozes līmeni asinīs. Šo
koeficientu izmanto, lai aprēķinātu korekcijas bolus devu, kad cukura līmenis asinīs ir augsts. (GA
līmenis) – (GA mērķa diapazons) = X. X ÷ (bolus devas korekcijas faktors) = bolus devas korekcijas
lielums

Bolus insulīns - insulīna deva, ko ievada, lai tas būtu pietiekamā daudzumā, kad ir sagaidāma glikozes
līmeņa celšanās asinīs (piemēram, pēc ēdiena vai uzkodu patēriņa) vai kad jāsamazina augsts
glikozes līmenis asinīs līdz mērķa diapazonam.

Brīdinājums par rezervuāra iztukšošanos - ieprogrammējams brīdinājums, kas ziņo, kad sūkņa
rezervuārā palicis noteikts skaits vienību, vai noteikts laiks, pēc kura rezervuārs būs tukšs.

Cal Reminder - sūknis ik pēc 12 stundām automātiski iedarbinās GA mērītāja st.st.:min.min. trauksmes
signālu, signalizējot, ka pašreizējā kalibrētā vērtība vairs nav derīga. Cal Reminder (Kalibrēšanas
atgādinājums) vērtība ir laikposms pirms pašreizējās kalibrētās vērtības derīguma beigām, lai
atgādinātu lietotājam, ka būs jāveic kalibrācija. Piemēram, ja Cal Reminder (Kalibrēšanas
atgādinājums) iestatīts uz 2 stundām, GA mērītāja st.st.:min.min trauksmes signāls tiks iedarbināts
2 stundas pirms kalibrēšanas laika.

Carb ratio (ogļhidrātu daļa) - ogļhidrātu daudzums, ko noārda 1 insulīna vienība. (Skatīt arī exch
ratio.)

Carb units - pārtikas ievade, izmantojot Bolus Wizard. Ievadītas (ogļhidrāti) gramos vai apmainītas.

CareLink® Personal - tiešsaistes pakalpojums, kas ļauj pārvaldīt diabēta datus internetā.

CH - ogļhidrāts

ComLink - radiofrekvenču (RF) uztvērējs un raidītājs, ko lieto, lai lejupielādētu sūkņa Paradigm datus
datorā.
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Com-Station - ierīce, ko lieto, lai lejuplādētu MiniMed 508 sūkni un pārsūtītu trešās personas mērītāja
datus uz datoru.

Darbība - insulīna mērījums, kas tiek iestatīts un izmantots ar Easy Bolus metodi.

Dual Wave® bolus - nekavējoties piegādājamās parastās bolus devas apvienojums ar Square Wave
bolus devu. Square Wave daļa tiek piegādāta noteiktā laikposmā vienmērīgi.

Easy Bolus™ - metode parastās bolus devas piegādei, izmantojot sūkņa Easy Bolus pogu.

Exch ratio (apmaiņas daļa) - insulīna daudzums, kas nepieciešams, lai nodrošinātu vienu (1)
ogļhidrātu apmaiņu. (Skatīt arī carb ratio.)

Express bolus - metode jebkuras bolus devas piegādei, izmantojot sūkņa Express Bolus pogu.

HbA1c - glikozēts hemoglobīns

HbA1c tests - hemoglobīna A1c tests, ko izmanto, lai skaidrotu glikozes līmeņa asinīs kontroli vai
līmeņu vidējās vērtības 2–3 mēnešu laikā.

High Glucose - sūknis sūtīs trauksmes signālu, ja sensors rādīs, ka lietotāja sensora glikozes līmenis
ir virs šīs vērtības. Šo opciju var ieslēgt vai izslēgt.

Hyperglycemic - paaugstināts glikozes līmenis asinīs, kas ir redzams, uzraugot glikozes līmeni asinīs,
novērojot vai nenovērojot vienu vai visus šādus simptomus: nelabums, vemšana, neskaidra redze,
galvassāpes, gremošanas traucējumi, bieža liela apjoma urinēšana, letarģija.

Hypoglycemic - zems glikozes līmenis asinīs, kas ir redzams, uzraugot glikozes līmeni asinīs,
novērojot vai nenovērojot vienu vai visus šādus simptomus: pārmērīgs izsalkums, trīce vai tremors,
svīšana, redzes izmaiņas, reibonis, galvassāpes, neskaidra runa, pēkšņas garastāvokļa vai
personības izmaiņas.

Infūzijas komplekts - ierīce, ko lieto, lai ievadītu un nostiprinātu zem ādas kanulu, piegādātu insulīnu
no sūkņa pa caurulītēm līdz ievadīšanas vietai.

Insulīna jutīgums - daudzums mg/dl (vai mmol/l), par kādu viena insulīna vienība samazina jūsu
glikozes līmeni asinīs (AG). (Bolus Wizard dati).

Insulīna koncentrācija - insulīna stiprums vai veids, ko ārsts izrakstījis lietotājam. Tas ietekmē ātrumu,
ar kādu sūknis piegādā insulīnu. Ja mainās lietotāja insulīna koncentrācija, sūknī jāpārprogrammē
pamata modeļi, pamata maksimālās devas un bolus devas padeves ātrums.

ISIG - sensora vērtības, kas rāda, vai devēja elektronika ar sensoru pastiprinātā sistēmā darbojas
pareizi. Ja ISIG vērtība ir zemāka par 24,00 nA vai lielāka par 29,00 nA, sazinieties ar izstrādājuma
servisu. Devēja nomaiņa var aizņemt zināmu laiku.

Ketona tests - ketons ir blakusprodukts, kas rodas, kad organisms enerģijas ieguvei sadedzina taukus,
nevis glikozi. Tā var būt pazīme insulīna trūkumam organismā. Ketona testā nosaka asinīs vai urīnā
koncentrētā ketona daudzumu.

Korekcijas bolus - insulīna daudzums, kas nepieciešams, lai augsts asins glikozes līmenis
pazeminātos līdz mērķa diapazonam.

Link
(1) Ieslēgt un iestatīt mērītāja iespēju, kas ļauj sūknim saņemt GA rādījumus no mērītāja, kas
komunicē ar sūkni.
(2) Šo terminu šajā sistēmā lieto arī, runājot par teksta hipersaitēm. Ja uz tām noklikšķina, nokļūst
citā sistēmas vietā vai citā tīmekļa vietnē.

Low Glucose - sūknis sūtīs trauksmes signālu, ja sensors rādīs, ka lietotāja sensora glikozes līmenis ir
zem šīs vērtības. Šo opciju var ieslēgt vai izslēgt.

Maks. pamata insulīns - maksimālais insulīna daudzums, ko sūknis piegādā vienā reizē. (Iestata
lietotājs).

Maksimālā bolus - maksimālais bolus insulīna daudzums, ko sūknis piegādā vienā reizē. (Iestata
lietotājs).

Manuāla bolus - ja Bolus Wizard ir aktīva, BOLUS MENU šī ir izvēles opcija. Viena metode bolus
ieprogrammēšanai bez Bolus Wizard.

Mērītāja opcija - opcija, kas ļauj sūknim saņemt BG rādījumus no piesaistītā BG mērītāja.
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Mērītājs - medicīniska ierīce aptuvenai glikozes koncentrācijas noteikšanai asinīs. Mazu asins pilienu
novieto uz vienreiz lietojamas testa strēmeles, kuru mērītājs nolasa, un rādījumus izmanto asins
glikozes līmeņa aprēķināšanai. Pēc tam mērītājs parāda līmeni kā mg/dl vai mmol/l.

Modelis, standarta - parastais pamata modelis, kas atbilst jūsu ikdienas aktivitātēm. Ja modeļu opcija
ir izslēgta, sūknis darbojas pēc jūsu standarta (pamata) modeļa.

Modeļa funkcija - paplašināta sūkņa funkcija, kas ļauj ieprogrammēt izvēles bazālās devas (A
modelis, B modelis), kas atbalsta aktivitātes vai glikozes līmeņa modeļus, kas neatbilst parastai
ikdienas kārtībai, taču jūsu dzīves ritmā gadās bieži. Šādas aktivitātes var būt kādas sporta
nodarbības, ar kurām nodarbojaties vienreiz nedēļā, gulēšanas laiku izmaiņas nedēļas nogalēs vai
hormonālās izmaiņas menstruāciju cikla laikā.

Pamata ātrums - sūkņa iestatījums, kas nodrošina nepārtrauktu insulīna infūziju, lai noturētu stabilu
glikozes līmeni starp ēdienreizēm un naktī. Bazālā insulīna deva imitē insulīna piegādi no aizkuņģa
dziedzera, kas nodrošina visu organismam nepieciešamo insulīnu un nav saistīts ar pārtikas
uzņemšanu.

Pamata insulīns - atbilstoši sūknī iepriekš ieprogrammētam profilam un individuāli izvēlētam
ātrumam insulīna sūknis katru stundu automātiski veic nepārtrauktu insulīna infūziju. Sūknis
nodrošina insulīna dienas devu, kas parasti atbilst pamata insulīna nepieciešamībai organismā
neēšanas laikā (piemēram, naktī un starp ēdienreizēm).

Pamata modeļi - lietotājs sūknī var ieprogrammēt līdz trim dažādiem pamata insulīna piegādes
ātruma modeļiem: standarta, A un B. Katrā modelī iespējams iestatīt līdz 48 pamata ātrumiem.

Pamata profils - pamata ātrums ar sākuma un beigu laiku. Lietotājs sūknī var ieprogrammēt vairākus
dažādus profilus, katru ar atšķirīgu bazālās devas diapazonu, lai 24 stundu laikposmā nodrošinātu
labāku glikozes līmeņa kontroli.

Parastā bolus - tūlītēja noteikta insulīna daudzuma padeve.

Pārtikas bolus - insulīna deva, kas nepieciešama, lai kompensētu sagaidāmu glikozes līmeņa
celšanos, kas notiek pēc ēšanas.

RF - radiofrekvence (RF).

Square Wave® bolus - bolus deva, kas tiek ievadīta vienmērīgi noteiktā laikposmā (no 30 minūtēm
līdz 8 stundām).

Square Wave daļa - (Sq) Dual Wave bolus devas otrā daļa. Square Wave daļa tiek piegādāta
vienmērīgi noteiktā laikposmā pēc tam, kad ir piegādāta NOW daļa.

Temp - īslaicīgs

Temp basal (tmp basal) - īslaicīga vienreizēja pamata insulīna piegāde noteiktā daudzumā un
ilgumā. Izmanto, lai atbalstītu nepieciešamību pēc insulīna īpašu aktivitāšu vai apstākļu
gadījumos, kas neietilpst parastā ikdienas kārtībā.

Transmtr ID - pašreiz lietotā raidītāja sērijas numurs.

Upload - process sūkņa vai mērītāja datu pārraidīšanai uz serveri CareLink® Personal.

Vidējā absolūtā starpība, % (Mean Absolute Difference — MAD%) - atspoguļo sensora
kalibrācijas precizitātes līmeni atbilstoši GA mērītāja rādījumiem. Jo mazāks ir šis skaitlis, jo lielāka
ir kalibrācijas precizitāte. MAD% aprēķina, dalot starpību starp sensora glikozes līmeņa un GA
mērītāja rādījumu tuvu esošiem pāriem ar GA mērītāja rādījumu un pēc tam aprēķinot vidējo
vērtību no visiem pāriem.
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